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KATA PENGANTAR 
 

 

Dalam buku pengolahan desain vector ini di khususkan untuk mengetahui bagaimana mahasiswa 

memahami cara – cara pengaturan bentuk gambar atau obyek vector, seperti mengubah ukuran 

obyek, memutar, mengkonversi, dan memanipulasi obyek. Bentuk vector mempunyai kelebihan 

dalam hal pengaturan ukuran, dimana perubahan ukuran bentuk obyek vector tidak perpengaruh 

pada tingkat ketajaman atau resolusi gambar. Berbeda dengan obyek atau gambar Bitmap , dimana 

ukuran dan ketajaman gambar sangat mempengauhi kuwalitas gambar tersebut. Bentuk vector 

dalam bentuk garis dan kurva, sehingga perubahan ukuran tidak mempengaruhi ketajaman gambar 

tersebut. 

Pembahasan buku ini sifatnya umum tidak hanya terpusat pada satu aplikasi seperti Coreldraw saja, 

tetapi juga membahas aplikasi vector yang lain , seperti Ilustrator. Kedua aplikasi tersebut memang 

membahas bentuk- bentuk dan pengolahan vector. Pembahasan buku in menitik beratkan pada 

Aplikasi CorelDraw , sedang Ilustrator hanya sebagian dari pembahasan. 

Pada buku ini mahasiswa diharapkan dapat memahami serta mampu menerapkan cara dan teknik 

pengaturan danpenglahan obyek vector baik secara teori maupun secara praktek. 
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BAB 1 
GAMBAR VEKTOR  

 

 Dalam bab 1 ini pembahasan pada pengetahuan umum tentang obyek vector baik kelebihan 

dan kekurangannya  

 Diharapkan dalam buku ini mahasiswa mampu mengetahui tentang perbandingan obyek vetor 

dan bitmap dari sisi kelebihan dan kekurangannya  

 

Gambar Vector merupakan gambar yang dibuat dengan menggunakan bantuan komputer dengan 

menggunakan urutan- urutan beberapa perintah atau pernyataan perhitungan matematika dalam 

bentuk garis dan kurva berbentuk gambar ruang dua dimensi atau tiga dimensi. Gambar vektor 

merupakan salah satu bentuk karya seniman grafis yang didibuat dan disimpan dalam bentuk file 

sebagai urutan pernyataan vektor. File gambar vektor menggambarkan serangkaian titik yang akan 

dihubungkan satu dengan yang lainny dan sering disebut sebagai file geometris. Bentuk Gam,bar 

vekstor  yang dibuat dengan aplikasi seperti Adobe Illustrator dan CorelDRAW yang biasa dipakai 

untuk menggambar vektor. 

1.1 APA ITU GAMBAR VEKTOR? 

Secara sederhana, gambar vektor didefinisikan dalam bentuk matematika dan dianggap kebalikan 

dari gambar raster seperti penjelasan tersebut diatas,dengan kata lain, gambar raster menyimpan 

data sebagai peta piksel sedangkan bambar vektor dalam bentuk garis dan kurva bentuk yang 

ditentukan secara matematis. Jika Anda memperbesar vektor, itu tidak akan memengaruhi 

kejelasannya. Tidak peduli seberapa jauh Anda memperbesar atau memperkecil, Anda akan selalu 

melihat tepi yang tajam – di situlah gambar ini berbeda dari gambar raster. Anda akan melihat piksel 

jika memperbesar gambar raster, sedangkan vektor dapat diskalakan tanpa batas. 

Anda dapat menemukan contoh desain vektor pada barang sehari-hari seperti bungkus bus atau 

barang cetak berskala besar seperti papan reklame Seperti gambar yang sering anda  lihat sehari-hari 

, jika Anda melihat desain datar, kemungkinan besar itu adalah desain vektor,perlu diingat, bahwa 

jika Anda melihat sesuatu yang seperti foto, itu adalah gambar raster. 

Jika Anda memerlukan sesuatu seperti logo, ikon, atau ilustrasi datar, gambar vektor sangat ideal. 

Alasan utamanya adalah bahwa mereka adalah file kecil meskipun skalabilitasnya tidak terbatas. 

Gambar vektor juga jauh lebih mudah untuk dimanipulasi jika Anda perlu membuat bentuk baru, 

menggabungkan dua titik, atau menyesuaikan kurva. 

1.2 MUNCULNYA GAMBAR VEKTOR. 

Beberapa jenis gambar komputer pertama adalah vektor, karena daya komputasi yang diperlukan 

untuk membuat gambar raster terlalu mahal. Komputer awal menggunakan tampilan vektor pada 

1960-an dan 70-an; video game seperti Asteroid 1979 juga menggunakan gambar vektor. Praktik ini 

berlanjut hingga tahun 1980-an, saat sebagian besar tampilan telah beralih ke gambar raster. 

Karena kebutuhan akan karya seni yang dicetak dalam berbagai ukuran dan desain web responsif 

yang beradaptasi dengan berbagai ukuran layar, file vektor merupakan kebutuhan desain 

modern. Gambar yang bersih dan dapat diskalakan yang memungkinkan kemungkinan visual yang 

menarik dengan bonus fungsionalitas tambahan. Tipografi modern hampir secara eksklusif dibuat 

menggunakan vektor. Teks yang Anda lihat sekarang adalah produk gambar vektor. Pemodelan 3D 
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dan gambar komputer (CG) yang anda lihat dalam film superhero blockbuster adalah konsekuensi 

langsung dari perkembangan seni vektor dan ilustrasi. 

1.3 UNTUK APA GAMBAR VEKTOR DIGUNAKAN? 

Seniman grafis, ilustrator dan desainer menggunakan grafis vektor untuk berbagai alasan, 
termasuk berikut ini: 

 Skalabilitas . Format vektor bagus untuk proyek yang memerlukan gambar yang dapat 

diskalakan, termasuk jenis dan teks yang dapat diskalakan. Misalnya, logo perusahaan dan 

merek ditampilkan dalam ukuran yang berbeda; mereka muncul di sudut aplikasi seluler atau 

di papan iklan pinggir jalan. Logo yang dibuat dengan gambar vektor dapat ditingkatkan atau 

diturunkan tanpa kehilangan kualitas atau membuat file besar.fitur skalabilitas gambar 

vektor yang menghasilkan kembalinya, setelah tidak disukai lagi oleh gambar raster pada 

1980-an. Gambar vektor awalnya digunakan dalam tampilan komputer pada 1960-an dan 

1970-an. Konsorsium World Wide Web bekerja pada Vector Markup Language, yang 

berkembang menjadi bahasa open source Scalable Vector Graphics yang berisi elemen vektor 

dan raster. 

 Pengembangan aplikasi dan web . Gambar vektor berguna dalam pengembangan aplikasi 

dan web karena aplikasi web dan gambar yang dikandungnya harus bekerja dengan berbagai 

ukuran layar dan jenis perangkat. Misalnya, Amazon WorkLink adalah aplikasi seluler yang 

memungkinkan representasi data perusahaan yang sepenuhnya interaktif di perangkat 

seluler karyawan. 

 Animasi. Gambar animasi juga biasanya dibuat sebagai file vektor, yang menyediakan gambar 

yang lebih bersih dan halus. 

 Desain berbantuan komputer ( CAD ). Program CAD sering menggunakan file vektor untuk 

pembuatan, teknik, dan desain karena skalabilitas dan kemudahannya dalam mengedit 

rumus matematika. 

1.4 VEKTOR VS. RASTER 

Bentuk gambar raster yang dalam memetaanya berbentuk ukuran bit,yang dapat ditampilkan secara  

langsung seperti layaknya gambar bitmap . Bentuk gambar raster terdiri dari  piksel yang tetap 

,diamana cara dan teknik pembuatannya tidak skalabel dibandingkan dengan gambar yang 

berbentuk vektor. Pada titik- titik tertentu, saat gambar raster diperbesar,maka akan terlihat 

dibagian tepinya menjadi tidak rata, dan tampak berpiksel. Gambar raster tidak dapat ditingkatkan 

tanpa harus mengorbankan kualitas gambar. 

Ada dua kategori utama format gambar di dunia seni digital — raster dan vektor. Kedua format 

memiliki kelebihan dan kekurangan, dan masing-masing ideal untuk berbagai jenis proyek digital. file 

gambar vektor menyimpan data visual menurut koordinat matematis, memetakan rangkaian titik, 

garis, dan bentuk untuk membuat gambar lengkap. Gambar vektor dapat diskalakan tanpa batas dan 

ideal untuk berbagai penggunaan  mulai dari ikon web terkecil hingga papan reklame terbesar. 

Ukuran file vektor lebih kecil dari pada gambar pxel, memungkinkan penyimpanan file lebih mudah 

dan lebih cepat karena ukuannya file yang kecil 

Meskipun desainer dan seniman menyukai gambar vektor karena alasan tersebut, masih ada 

beberapa keadaan di mana memilih format gambar yang berbeda lebih masuk akal. Kunjungi bab 

sebelumnya untuk menjelajahi pro dan kontra gambar vektor , dan baca terus untuk mempelajari 

lebih lanjut tentang gambar raster. 

https://www.techtarget.com/searchcontentmanagement/definition/web-development-framework-WDF
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Gambar vektor dan raster dapat terlihat berbeda. Ini karena gambar vektor harus memiliki bentuk 

terpisah untuk setiap naungan warna, sedangkan gambar raster dapat memiliki setiap piksel dengan 

warna yang berbeda, menunjukkan gradasi warna halus dan kedalaman lebih jelas. Pada ukuran yang 

lebih besar, tepi gambar raster menjadi tidak rata dan gambar menjadi pixilate. Gambar vektor lebih 

terukur. 

Hubungan disetiap gamabar satu dengan gambar yang lain antara setiap piksel dan gambar raster 

memiliki kemampuan memori yang berbeda – beda yang  ada dikomputer. Komputer harus 

menyimpan informasi untuk setiap piksel dari gambar raster, sedangkan gambar vektor hanya 

menyimpan rangkaian titik yang perlu dihubungkan dengan garis, kurva, dll. Akibatnya, file vektor 

biasanya lebih kecil daripada file raster. File gambar vektor lebih mudah dimodifikasi daripada file 

gambar raster karena alasan ini. 

Gambar vektor dan raster dapat diubah menjadi satu sama lain dengan perangkat lunak yang tepat. 

Adobe Illustrator dan Adobe Photoshop adalah contoh perangkat lunak yang memungkinkan 

pengguna untuk mengubah satu format gambar ke format File raster sangat baik untuk 

menggambarkan kedalaman warna , karena setiap piksel dapat memiliki warna yang berbeda. Dan 

ada lebih banyak piksel yang bisa menjadi warna unik daripada vektor yang bisa menjadi warna unik. 

Ini membuat format file raster bagus untuk mengedit foto digital. 

File raster sangat baik untuk menggambarkan kedalaman warna , karena setiap piksel dapat memiliki 

warna yang berbeda. Dan ada lebih banyak piksel yang bisa menjadi warna unik daripada vektor yang 

bisa menjadi warna unik. Ini membuat format file raster bagus untuk mengedit foto digital. 

1.5 KEUNTUNGAN DAN KERUGIAN DARI GAMBAR VEKTOR 

Penting untuk mempertimbangkan keuntungan dan kerugian menggunakan file vektor. 

Keuntungan 

 Skalabilitas. Seperti disebutkan sebelumnya, ini adalah keuntungan utama dari gambar 

vektor. Karena gambar vektor diturunkan dari hubungan vektor matematis, atau hubungan 

antara titik yang menciptakan garis dan kurva, gambar tersebut tampak bersih dan tepat 

pada ukuran berapa pun. 

 Ukuran fila pada gambar vektor umumnya memiliki ukuran file yang kecil karena hanya 

menyimpan sejumlah kecil titik dan hubungan matematis. Hubungan tersebut diekspresikan 

https://knowledge.autodesk.com/support/autocad-raster-design/learn-explore/caas/CloudHelp/cloudhelp/2021/ENU/AutoCAD-RasterDesign/files/GUID-7CD2C7E0-77AF-4833-83D0-797FC1E57A28-htm.html
https://knowledge.autodesk.com/support/autocad-raster-design/learn-explore/caas/CloudHelp/cloudhelp/2021/ENU/AutoCAD-RasterDesign/files/GUID-7CD2C7E0-77AF-4833-83D0-797FC1E57A28-htm.html


4 
 

dalam kode, yang kurang intensif memori dibandingkan dengan menyimpan piksel. 

 Mudah untuk diedit. File vektor mudah diedit karena pengguna dapat mengubah hubungan 

vektor dengan cepat untuk menukar warna atau mengubah bentuk garis, misalnya. Ini 

berguna dalam proses berulang , seperti desain grafis, yang membutuhkan banyak 

pengeditan. 

 Mudah untuk memuat. Karena ukuran file lebih kecil, mudah untuk mem-port dan memuat 

file vektor ke perangkat dan program yang berbeda. 

 Mudah untuk digandakan. Juga mudah untuk membuat klon dari gambar vektor dan 

menyalin fitur tertentu dari satu gambar ke gambar lainnya. 

 presisi. Kemampuan untuk menskalakan gambar vektor ke atas atau ke bawah berarti 

mereka memiliki tampilan dan nuansa yang tepat. 

Kekurangan 

 Kurang detail. File vektor terbatas dalam menangani gambar yang kompleks. Misalnya, foto 

memerlukan bayangan dan pencampuran warna yang tidak dapat disediakan oleh file vektor 

sebaik file raster. 

 Persyaratan keterampilan dan waktu. File vektor dapat membutuhkan lebih banyak 

keterampilan dan waktu untuk membuatnya. 

 Dukungan peramban terbatas. Ada lebih sedikit dukungan untuk gambar vektor di browser 

web daripada untuk gambar raster. 

 Inkonsistensi. Gambar vektor dapat divariasikan dari satu aplikasi ke aplikasi lainnya, 

tergantung pada seberapa kompatibel rendering dan pembuatan aplikasi, di antara faktor 

lainnya. 

1.6 JENIS FILE VEKTOR 

Ada beberapa jenis file vektor yang umum digunakan . Mereka termasuk yang berikut: 

 .ai -- File Adobe Illustrator 

 .cdr -- File Gambar CorelDRAW 

 .dxf -- Menggambar File Format Pertukaran 

 .eps -- Berkas PostScript Terenkapsulasi 

 .svg -- File Gambar Vektor yang Dapat Diskalakan 

 .wmf -- Windows Metafile 

jenis file yang berbeda digunakan untuk tugas yang berbeda. Misalnya, file AI biasanya digunakan di 

media cetak dan gambar digital. File EPS dapat berupa file raster dan vektor. Mereka biasanya berisi 

elemen desain yang lebih kecil yang dapat disematkan dalam desain yang lebih besar. Ini 

membuatnya cocok untuk mengirim logo, yang sering digabungkan ke dalam desain yang lebih besar. 

1.7 APA ITU FILE AI? 

File AI adalah gambar vektor yang disimpan dalam format Adobe Illustrator Artwork (AI). Itu dibuat 

oleh Adobe Illustrator atau diekspor oleh aplikasi grafis lain, seperti Adobe Photoshop. File AI 

disimpan dalam format vektor yang terdiri dari jalur yang dihubungkan oleh titik, bukan data gambar 

bitmap , memungkinkan pengguna untuk memperbesarnya tanpa kehilangan kualitas gambar apa 

pun. 

Adobe Illustrator adalah salah satu aplikasi gambar vektor paling umum dan favorit di antara 

https://www.techtarget.com/searchsoftwarequality/definition/iterative
https://techterms.com/definition/vectorgraphic
https://techterms.com/definition/bitmap
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seniman grafis, seniman visual, dan desainer web. Mereka menggunakan aplikasi untuk mendesain 

karya seni vektor, seperti ikon, logo, dan tata letak web & seluler. 

Saat Anda menyimpan karya seni di Illustrator, aplikasi membuat file AI untuk menyimpan konten 

desain. File adalah file yang berfungsi, yang berarti Anda dapat menutupnya, membukanya kembali, 

dan melanjutkan mengedit karya seni setelah menyimpannya. 

 

 

1.8 APA ITU FILE CDR? 

File CDR adalah gambar vektor atau dokumen yang dibuat dengan CorelDRAW, ilustrasi vektor dan 

program tata letak halaman. Ini berisi informasi yang membentuk dokumen atau gambar, yang 

mungkin termasuk teks, tabel, garis, bentuk, gambar, warna, dan properti efek. Pengguna 

CorelDRAW membuat file CDR untuk menyusun dokumen seperti surat, brosur, tabloid, amplop, 

kartu pos, halaman web, dan spanduk web. 

File CDR adalah jenis file utama yang terkait dengan CorelDRAW. Saat Anda menyimpan dokumen 

Anda dalam format CDR, CorelDRAW membuat file CDR untuk menyimpan konten dokumen 

CorelDRAW termasuk dalam CorelDRAW Graphics Suite bersama dengan aplikasi berikut: 

 Corel PHOTO-PAINT - Aplikasi pengeditan gambar untuk foto digital 

 Corel Font Manager - Utilitas untuk mengelola font 

 CorelDRAW.app - Program ilustrasi vektor online yang dapat diakses melalui browser web 

 Corel CAPTURE - Utilitas tangkapan layar sekali klik (hanya tersedia dengan versi Windows) 

1.9 APA ITU FILE EPS? 

File EPS adalah gambar vektor yang disimpan dalam format Encapsulated PostScript (EPS). Ini berisi 

data gambar berformat PostScript, yang ideal untuk menskalakan gambar beresolusi tinggi, dan 

mungkin menyertakan data gambar bitmap dan teks. File EPS juga menyimpan gambar bitmap 

tertanam beresolusi rendah untuk melihat pratinjau gambar 

Adobe mengembangkan format EPS pada akhir 1980-an untuk menjadi standar pertukaran gambar di 

berbagai platform dan perangkat. Sementara berbagai aplikasi dan pengguna mengadopsi format 

tersebut, format gambar lain, seperti .JPEG dan .PNG , membayanginya. 
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Meskipun EPS tidak pernah digunakan secara luas seperti yang dimaksudkan Adobe, para profesional 

grafis biasanya menyimpan karya seni mereka, seperti ikon dan gambar, dalam format. Selain itu, 

desainer grafis sering menggunakan EPS untuk pekerjaan cetak besar, seperti poster, spanduk, dan 

iklan billboard, karena skalabilitasnya. 

Kebanyakan desainer grafis menggunakan editor gambar vektor profesional, seperti Adobe Illustrator 

atau Serif Affinity Designer, untuk menyimpan karya seni sebagai file EPS. Misalnya, untuk membuat 

file EPS dengan Illustrator, 

1.10 APA ITU FILE SVG? 

File SVG adalah gambar yang disimpan dalam format gambar vektor dua dimensi yang dibuat oleh 

World Wide Web Consortium (W3C). Ini menyimpan informasi yang menjelaskan gambar dalam 

format teks berdasarkan XML . File SVG dapat menyertakan bentuk vektor, gambar raster yang 

disematkan (juga dikenal sebagai gambar bitmap), dan teks 

Format SVG adalah standar terbuka yang dikembangkan di bawah W3C, dengan kontribusi dari 

Adobe, dan awalnya dirilis pada tahun 2001. W3C telah merilis beberapa spesifikasi SVG sejak tahun 

2001, termasuk SVG 1.1, SVG Tiny 1.2, dan SVG 2.0. 

Profesional grafis biasanya menggunakan file SVG untuk menyimpan grafis web, seluler, dan cetak. 

Desainer web juga menerbitkan gambar online dalam format SVG karena dapat diskalakan dan dapat 

dimodifikasi dengan CSS dan bahasa skrip, seperti JavaScript . 

Anda dapat membuat gambar SVG dengan berbagai Tool, tetapi salah satu yang paling menonjol 

yang digunakan oleh para profesional adalah Adobe Illustrator (Windows dan macOS). Untuk 

mengekspor desain sebagai file SVG dengan Illustrator 

1.11 APA ITU FILE WMF? 

File WMF adalah gambar vektor yang disimpan dalam format Windows Metafile Format (WMF) 

berpemilik yang dikembangkan oleh Microsoft. Ini berisi serangkaian catatan metafile yang 

menyimpan operasi menggambar, termasuk perintah untuk menggambar garis, lingkaran, dan 

persegi panjang yang membentuk gambar. File WMF juga mendukung operasi menggambar bitmap 

File WMF awalnya muncul pada tahun 1988 ketika Microsoft merilis Windows 2.0. Microsoft 

kemudian menerbitkan spesifikasi format file WMF dengan rilis Windows 3.0 pada tahun 1992 dan 

menerbitkan spesifikasi berikutnya pada tahun 2006. Microsoft terus menerbitkan pembaruan ke 

format secara teratur. 
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WMF terutama digunakan sebagai wadah untuk gambar vektor dan mendukung data gambar raster . 

Selain itu, mendukung data gambar 16-bit yang dapat diskalakan dan output pada definisi yang lebih 

tinggi, yang sangat berguna saat memodifikasi gambar dalam editor gambar dan mencetak gambar 

berkualitas tinggi. 

Format WMF menyimpan data gambar dalam serangkaian struktur rekaman metafile. Masing-masing 

record ini menyimpan perintah menggambar, definisi objek, dan pengaturan konfigurasi. 

WMF sudah umum di tahun 1990-an, terutama di aplikasi Windows, seperti Microsoft Word, 

Publisher, dan PowerPoint. Namun, karena keterbatasan data 16-bit dan ketergantungan perangkat, 

Microsoft mengganti WMF dengan format Enhanced Windows Metafile ( .EMF ) pada tahun 1992 

ketika merilis Windows NT 3.1. 

Editor gambar mungkin masih menyimpan gambar vektor sebagai file WMF dan EMF. Namun, format 

Scalable Vector Graphics ( .SVG ) dan Encapsulated PostScript ( .EPS ) sebagian besar telah 

menggantikan format tersebut. 

SOAL LATIHAN 

 

1. Jelaskan kelebihan dan kekurangan bentuk obyek vector dan bitmap! 

2. Sebutkan dan jelaskan keluaran format dari obyek vector! 

3. Sebutkan dan jelaskan keluaran format dari obyek bitmap! 

4. Sebutkan format file yang dapat di akses atau dibaca baik bentuk obyek Vector mapun 

obyek bitmap! 

5. Sebutkan 3 aplikasi yang mampu mengolah obyek dalam bentuk Vector ! 
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BAB 2 
 SENI VECTOR 

 

 Dalam bab ini membahas tentang seni vector dan jeis – jenis yang ada di dalamnya serta 

pengertian dan sejarahnya 

 Mahasiswa diharapkan mampu dan memahami serta dapat menerapkan seni vector dan 

bidang yang dipelajarinya, serta mempu menerapkan manfaat dan kegunaan dari seni vector 

 

Seni vektor adalah istilah teknis untuk menggunakan algoritma matematika untuk membuat ilustrasi 

sederhana menggunakan bentuk geometris, garis, dan kurva. Desain berbasis matematika ini 

menggunakan geometri dan disimpan sebagai rangkaian rumus, bukan piksel seperti dalam fotografi. 

Gambar vektor muncul dalam berbagai format. Anda mungkin melihat ekstensi file menampilkan 

.eps atau .svg atau .ai atau .pdf. Masing-masing memiliki kegunaan yang berbeda. 

Menggunakan elemen desain yang ditentukan menggunakan urutan pernyataan atau perintah 

matematika, pengguna dapat membuat gambar vektor dua atau tiga dimensi yang menakjubkan. 

Disebut vektor, garis, titik, kurva, dan bentuk dalam gambar ini memungkinkan desainer membuat 

karya seni yang dapat diskalakan hampir di mana saja dan dalam ukuran apa pun tanpa kehilangan 

kualitas. 

Meskipun mereka terutama berada di ruang digital, vektor ada di dunia di seandar anda – saat Anda 

melihat bungkus bus atau logo perusahaan di sisi bangunan, itu adalah desain seni vektor. Jika Anda 

sedang mencari desain dengan tepi bersih dan tampilan bersih, perangkat lunak gambar vektor 

memungkinkan Anda membuat karya seni yang menakjubkan ini. 

Ilustrasi vektor adalah keterampilan desain yang berharga bagi desainer digital karena 

memungkinkan mereka mengubah ukuran desain tanpa batas tanpa mengorbankan kualitas. Anda 

akan membahasnya dan mendalami apa itu gambar vektor, mengapa Anda harus menggunakannya, 

apa yang dapat Anda buat, dan siapa yang menggunakan desain ini dalam panduan ini. 

2.1 YANG BISA DIBUAT DENGAN SENI VEKTOR 

Desainer dan ilustrator profesional dan non-profesional di semua genre menggunakan seni vektor 

dalam banyak cara untuk membuat gambar yang berani dan tajam untuk digunakan di mana saja 

misalnya: 

 Desain Web dan UX (desain Pengalaman Pengguna): Karena skalabilitas gambar vektor, ini 

adalah Tool kreatif yang sempurna untuk desain web. Satu gambar dapat muncul di berbagai 

perangkat dengan berbagai ukuran tanpa distorsi atau penurunan kualitas. 

 Logo: Anda dapat mendesain logo menggunakan bentuk sederhana yang dapat diledakkan 

hingga tak terbatas, dan desain Anda tidak akan pernah kehilangan kualitas. Logo harus 

berkualitas tinggi dan konsisten, dan fleksibilitas gambar vektor memungkinkan keduanya 

berada di hampir semua aplikasi yang dapat dibayangkan. 

 Baliho, poster, dan selebaran: Seni vektor bernyanyi di papan reklame, poster, dan selebaran 

karena sangat bersih, jelas, konsisten, dan tajam, tidak peduli seberapa besar atau kecilnya. 

 Pakaian: Karya seni vektor harus dimiliki untuk proses bordir dan sublimasi yang digunakan 

dalam pembuatan pakaian adat sehingga mesin dapat mengikuti garis yang bersih dan tajam. 
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Dan jika Anda ingin mendesain kaos, selimut, keramik, atau hadiah khusus lainnya, 

perusahaan cetak sesuai permintaan lebih memilih seni vektor. 

Munculnya "desain datar" antara 2010 dan 2020 menjadi katalis bagi siapa yang menciptakan dan 

menggunakan seni vektor. Sebelumnya, merek lebih menyukai desain yang menampilkan drop 

shadow, embossing, atau sangat detail. Kemudian, pergeseran terjadi selama dekade ini, condong ke 

arah desain yang lebih bersih dan tajam. Alih-alih desain yang menampilkan banyak "gangguan", 

seperti tekstur dan fitur ornamen, merek ingin melihat desain yang minimalis, bersih, dan tajam. 

Seniman digital sebagian besar menggunakan seni vektor untuk meningkatkan presentasi digital, 

infografis, aplikasi seluler, dan situs web. Anda juga akan menemukan gambar ini dalam aset 

periklanan dan pemasaran serta jaminan merek lainnya. Contoh lain tentang siapa yang membuat 

dan menggunakan seni vektor meliputi: 

 Desainer web/UX: Desainer ini lebih menyukai gambar vektor karena terlihat bagus terlepas 

dari perangkat Anda. Skalabilitas gambar ini membuatnya responsif, jadi meskipun Anda 

melihatnya di perangkat genggam atau monitor besar, gambarnya tetap jelas. Sebagai nilai 

tambah, gambar vektor mendukung transparansi, memperluas kemampuan perancang web 

secara eksponensial. 

 Industri cetak: Desainer grafis menggunakan seni vektor dalam industri cetak karena mereka 

memberikan kualitas yang lebih tinggi, desain yang lebih tajam daripada gambar raster. 

Misalnya, jika desainer ingin mencetak pada pakaian, tidak ada kehilangan kejelasan atau 

kualitas. 

 Ilustrator: Para profesional ini menggunakan perangkat lunak seni vektor untuk 

menghasilkan keluaran yang serupa dengan jika mereka tidak menggunakan Tool digital – 

garis tajam, gambar organik, dan gambar realistis. Misalnya, jika mereka perlu membuat 

gambar yang menampilkan teknik warna, pencahayaan, dan bayangan, mereka dapat 

melakukannya dengan gambar vektor. 

 CAD: CAD adalah Tool pemetaan 3D yang menggunakan logika serupa dengan perangkat 

lunak desain vektor. Misalnya, jika Anda ingin membuat kubus, Anda akan menggunakan 

prinsip desain yang sama di mana Anda memetakan titik tertentu dan menggabungkannya 

dengan garis, dan itu adalah geometri yang sama yang akan Anda gunakan untuk membuat 

vektor. Ketika insinyur perlu memetakan gambar yang kompleks, mereka dapat 

menggunakan matematika itu untuk membuat desain tersebut. Misalnya, jika mereka 

mendesain lereng bukit dengan kemiringan yang tampak keren, itu semua adalah vektor dan 

poligon kecil. 

2.2 SENI VEKTOR DALAM BUDAYA POPULER 

Seni vektor ada di seandar anda. Apa yang dimulai sebagai solusi untuk masalah teknik pada awal 

1960-an dengan cepat merevolusi gambar komputer, dimulai dengan Sketchpad. Gambar vektor 

mencapai arus utama untuk aplikasi teknis dengan cepat. Dan tidak lama kemudian, pikiran kreatif 

mulai mengubah gambar vektor menjadi bentuk seni. 

Novel grafis, animasi, dan video game adalah titik transisi yang logis. Saat ini, seni vektor muncul di 

seluruh budaya pop, termasuk seni dinding, pakaian, dan aksesori. Jika Anda memakai kaos 

bergambar atau topi bersulam, karya seni tersebut mungkin melibatkan gambar vektor. Bahkan 

seniman tato menggunakan media digital ini untuk meningkatkan seni mereka. 
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Seni vektor terasa seperti tujuan aslinya untuk ilustrasi buku komik. Sementara sebagian besar 

seniman membuat sketsa karakter asli mereka dan beberapa ide dengan tangan, seni vektor 

membantu menghidupkan karakter ini sambil mempercepat proses pembuatan buku komik. Setiap 

seniman memiliki metode yang unik, tetapi banyak di industri ini yang dengan sepenuh hati 

menggunakan Tool seni digital. Itu berarti mereka membuat sketsa dengan stylus daripada pensil dan 

kertas. Bagi mereka yang membuat sketsa dengan pena dan kertas, kreasi tersebut dipindai dan 

diubah menjadi gambar vektor untuk manipulasi digital lebih lanjut. 

 

Setelah gambar menjadi digital, menjadi mudah bagi seniman untuk berkolaborasi dengan editor 

untuk menyelesaikan produk jadi. Ilustrator terkenal seperti Zazo Aguiar menggunakan ilustrasi seni 

vektor untuk membuat buku komik dan novel grafis untuk merek seperti Disney, Coca-Cola, dan 

Warner Bros. 

Program seperti CorelDRAW memudahkan untuk mengubah sketsa yang digambar tangan menjadi 

vektor digital. Misalnya, fitur PowerTRACE dapat melakukan pekerjaan berat, secara instan 

mengubah piksel dari gambar yang dipindai atau sketsa digital menjadi vektor. 

2.3 ANIMASI DENGAN SENI VEKTOR 

Semudah grafis vektor berpasangan dengan ilustrasi, mereka melakukan lebih banyak lagi untuk 

karya seni yang bergerak. Vektor dibuat dengan persamaan matematika yang memaksa objek untuk 

tetap proporsional dengan gerakan. Itu memberikan tampilan yang lebih halus dan bersih jika 

dibandingkan dengan gambar berpiksel yang bergerak. Sementara beberapa animasi menggunakan 

gambar bitmap, gambar vektor jauh lebih umum. 
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Salah satu contoh animasi seni vektor yang terlintas dalam pikiran adalah GIF. Gambar animasi 

pendek ini meledak popularitasnya di seluruh dunia digital, mencapai puncaknya pada tahun 2016 

ketika pengguna membanjiri platform media sosial populer seperti Tenor, yang dibuat semata-mata 

untuk berkomunikasi dalam gambar animasi. Saat ini, anda masih menyukai GIF yang bagus karena 

gambar lebih kuat dari kata-kata, dan terkadang tidak ada cara yang lebih baik untuk merangkum 

perasaan selain dengan menggerakkan gambar. Karena popularitas animasi ini, ada banyak Tool 

untuk mendukung kreativitas Anda. Cobalah animasi seni vektor sederhana Anda sendiri 

menggunakan program seperti CorelDRAW untuk memanipulasi vektor dan menambahkan gerakan, 

membuat GIF animasi. 

2.4 SENI VEKTOR DALAM VIDEO GAME 

Gambar video game telah berkembang jauh sejak zaman bermain Mario Bros dalam 8-bit. Dengan 

resolusi 4K yang sekarang menjadi standar di seluruh papan untuk tampilan grafis, anda telah 

mencapai era baru dalam permintaan akan kualitas dan detail dalam grafis video game.  

 

Di masa-masa awalnya, seni vektor digunakan dalam game arcade seperti Atari's Asteroids , yang 
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dirilis pada tahun 1979. Dan meskipun seni vektor saat ini diakui lebih kompleks, pada dasarnya 

teknologi grafis yang sama digunakan untuk membuat karya seni yang sangat berStyle di video game 

modern. Judul-judul populer seperti Zero Dawn dan Elden Ring menggunakan berbagai teknologi 

untuk mencapai lingkungan 3D yang imersif. Tapi anda berani bertaruh bahwa vektor adalah bagian 

dari proses kreatif mereka. Anda akan menemukan seni vektor dalam segala hal mulai dari game 

indie hingga produksi studio besar 

Anda dapat melihat seni vektor di setiap bagian kehidupan "visual". Elemen dasar dalam branding 

dan pemasaran, dan sama lazimnya dalam budaya pop. Karya seni yang mengisi halaman novel grafis 

atau membenamkan pemain dalam video game adalah contoh seni vektor yang bagus dalam budaya 

pop. Ini adalah media yang terus-menerus di datangi seniman karena gambar vektor hanya 

menghasilkan garis yang lebih bersih dan tajam tanpa distorsi. Anda mungkin memiliki setidaknya 

satu kaos grafis atau poster dengan sedikit seni vektor. 

Lebih dari 60 tahun setelah penemuan gambar vektor, gambar-gambar ini lebih umum daripada 

sebelumnya. Banyak seniman berbakat menggunakan teknologi seperti CorelDRAW untuk 

memanfaatkan gambar vektor untuk karya seni mereka, merampingkan proses replikasi saat mereka 

membuat buku komik, animasi, tato, dan banyak lagi. Yang keren adalah seni vektor tidak hanya 

untuk seniman, dan siapa pun yang memiliki kreativitas dapat membuat seni yang didukung 

teknologi ini. 

Di bab selanjutnya dari seri ini, Anda akan belajar lebih banyak tentang seni vektor dalam bisnis , 

termasuk karier dalam desain web, desain grafis, periklanan, pemasaran, industri percetakan, dan 

teknik. 

2.5 MERANCANG DENGAN VEKTOR 

Teknologi gambar vektor sangat fleksibel sekaligus indah. Seni Vektor dapat diskalakan, dapat diedit, 

dan dapat digunakan hampir di mana saja, di hampir semua permukaan, termasuk kertas, kain, vinil, 

kaca, dan plastik. Profesional dan non-profesional menggunakan gambar vektor baik secara kreatif 

maupun teknis. 

Desainer menggunakan seni vektor untuk desain web, logo, papan nama, publikasi, pengemasan, 

pemasaran, iklan, dan tampilan ritel. Non-profesional menggunakannya untuk membuat desain pada 

pakaian, keramik, buletin, spanduk, kartu, undangan, dan situs web pribadi. 

2.6 DESAIN WEB DAN UX 

Karena skalabilitas gambar vektor, ini adalah Tool kreatif yang sempurna untuk desain web. Satu 

desain dapat muncul di perangkat berbeda dengan ukuran berbeda tanpa distorsi. Desain responsif 

semacam ini berarti Anda dapat melihat gambar dan teks di komputer desktop dan ponsel Anda 

karena skalabilitas teknologi gambar vektor. 

Desainer web grafis vektor menggunakan file SVG (scalable vector graphics) untuk gambar, logo, 

tipografi, dan elemen grafis lainnya. Karena pengguna membaca teks di berbagai perangkat, desainer 

juga harus membuat font sebagai desain vektor. Meskipun komputer memperlakukan file ini seperti 

font, file tersebut dirender sebagai vektor. Sebagai contoh, 

 Font raster: mesin terbang adalah sistem bitmap yang menggambar garis atau simbol tunggal 

dalam font 

 Font vektor: mesin terbang adalah kumpulan titik akhir garis yang menentukan segmen garis 
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yang digunakan untuk menggambar karakter atau simbol font 

SVG ditulis dalam XML, bahasa markup yang digunakan untuk menyimpan dan mentransfer informasi 

digital. Untuk contoh tampilan vektor dalam desain web, 

Jadi, tidak seperti gambar raster yang merupakan file jpeg atau png, vektor dapat diskalakan, dicari, 

diindeks, dan dimodifikasi dalam XML. Mereka lebih kecil dari file raster, yang berarti waktu 

pemuatan situs web lebih cepat. Mereka sempurna untuk desain web karena Anda dapat 

menggunakannya dalam berbagai ukuran tanpa kehilangan kualitas. Misalnya, jika Anda membuat 

GIF animasi dan memperbesar, Anda akan melihat piksel karena itu adalah raster. Namun, karena ini 

100% matematika, memperbesar vektor tidak menyebabkan pikselasi. 

2.7 SENI VEKTOR DI DUNIA BISNIS 

Bayangkan tugas sederhana seperti pergi ke toko kelontong untuk membeli sepotong roti. Berapa 

banyak karya seni vektor yang akan Anda lihat? Mungkin lebih dari yang Anda pikirkan. Berikut 

beberapa contohnya: 

 Billboard atau iklan lainnya 

 Stiker bemper pada mobil 

 Signage toko dan pengemasan produk 

 T-shirt grafis dan tas jinjing 

Ini adalah contoh visual, tetapi ada juga contoh seni vektor yang kurang jelas dalam skenario 

ini. Misalnya, seorang arsitek menggunakan perangkat lunak berbasis vektor untuk membuat denah 

bangunan toko. Mobil atau sepeda Anda dimulai sebagai konsep seni vektor, yang selanjutnya 

menunjukkan bahwa itu ada di seandar anda. 

2.8 SENI VEKTOR ADA DI MANA SAJA 

Dengan lebih dari 100.000 seniman grafis dan hampir 100.000 desainer web yang bekerja di 

perusahaan pemerintah, pendidikan, publik, dan swasta, jelas bahwa seni vektor sangat fleksibel dan 

ideal untuk banyak aplikasi. 

Garis-garis halus dan tepi tajamnya tidak pernah buram atau berpiksel saat diperbesar, membuat 

seni vektor sama bersih dan tajamnya pada ikon situs web kecil atau papan reklame. Gambar vektor 

ada di mana-mana — mulai dari situs web bank Anda hingga menu takeout restoran favorit Anda. 

2.9 BAGAIMANA SENI VEKTOR MENGUATKAN INDUSTRI DAN KARIR 

Seni vektor adalah hal yang umum, dan dibuat serta digunakan oleh banyak profesional yang 

berbeda — bukan hanya seniman dan desainer grafis. Anda mengeksplorasi bagaimana berbagai 

industri menggunakan gambar vektor untuk komunikasi visual. 

2.9.1 DESAIN WEB 

Dengan munculnya desain web responsif yang dimulai seandar tahun 2010, semakin penting bagi 

gambar online untuk terlihat bagus terlepas dari ukuran layarnya — mulai dari smartphone hingga 

layar ultra-HD yang besar. Sekarang, sebagian besar situs web yang Anda kunjungi hari ini 

menggunakan seni vektor dalam kapasitas tertentu. 

 

Skalabilitas dan ukuran file yang lebih kecil membuat gambar vektor ideal untuk elemen web 

dibandingkan dengan jenis file lainnya. Meskipun desainer web tidak perlu membuat gambar vektor 
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yang mereka gunakan, mereka harus terbiasa dengan jenis file vektor dan cara menempatkannya di 

dalam templat dan halaman web. 

2.9.2 DESAIN GRAFIS 

Seni vektor sangat penting untuk industri desain grafis, memungkinkan desainer dengan mudah 

membuat dan menskalakan seni untuk digunakan di semua jenis media cetak dan digital. 

Desainer grafis membuat gambar raster dan vektor , memilih Style visual dan format file sesuai 

dengan kebutuhan proyek dan penggunaan akhir. Gambar raster bagus untuk gambar dan foto yang 

sangat realistis, sementara gambar vektor lebih masuk akal untuk karya seni datar, ilustratif, dan 

berStyle yang direproduksi dalam format besar. 

2.9.3 PEMASARAN IKLAN 

Industri periklanan dan pemasaran menggunakan gambar vektor dalam desain yang mereka buat 

untuk mempromosikan merek di berbagai media fisik dan digital, termasuk: 

 Baliho 

 Iklan daring 

 Stiker dan stiker 

 Kemasan produk 

 T-shirt 

2.9.4 GAMBAR MEDIA SOSIAL 

Saat desain iklan menggunakan gambar vektor, pengiklan dapat menampilkan materi pemasaran 

merek di mana saja. File vektor diskalakan tanpa batas, jadi tidak ada kekhawatiran tentang citra 

pixelating, bahkan di papan reklame raksasa atau sebagai pembungkus bus. 

2.9.5 NDUSTRI PERCETAKAN 

Produksi cetak secara intrinsik terkait dengan desain grafis, pemasaran, dan periklanan, membuatnya 

sangat bergantung pada gambar vektor. Beberapa materi cetak menggunakan gambar raster, tetapi 

mungkin sulit untuk mendukung kualitas gambar raster saat mencetak pada ukuran yang lebih 

besar. Pencetakan format lebar dengan file vektor menghasilkan desain menakjubkan dengan lebar 

hingga enam kaki. 

2.10 PERANGKAT LUNAK GAMBAR VEKTOR DIGUNAKAN UNTUK MEMBUAT BERBAGAI BAHAN 

CETAK, TERMASUK: 

 Brosur 

 Selebaran 

 Menu 

 Poster 

 Tanda-tanda 

 Kartu pos 

Bekerja di industri cetak membutuhkan pengetahuan tentang file seni digital, termasuk memahami 

pengeditan, penskalaan, pemotongan, dan penyesuaian lainnya untuk menciptakan produk cetak 

yang berkualitas. Seniman grafis vektor menggunakan format file EPS, SVG, CDR, AI, dan PDF. 
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2.11 JURNALISME DAN EDITORIAL 

Jurnalisme dan pelaporan mungkin sangat bergantung pada fotografi dan gambar raster, tetapi 

banyak publikasi cetak dan online juga menggunakan gambar editorial untuk melengkapi 

artikel. Gambar editorial dapat berupa karya seni yang digambar dengan tangan, seni digital berbasis 

raster, gambar vektor, atau kombinasi dari ketiganya. 

Karena fotografi seni editorial mendahului fotografi, ia memiliki sejarah panjang dan telah 

berkembang secara signifikan selama bertahun-tahun. Saat ini, ilustrasi editorial cenderung sangat 

konseptual dan menarik secara visual, membantu pembaca mengklik dan terhubung dengan artikel 

yang menggugah pikiran. 

1.12 REKAYASA 

Tampaknya gambar vektor terutama digunakan untuk tujuan estetika dan periklanan, tetapi juga 

memiliki kegunaan teknis. Insinyur menggunakan perangkat lunak CAD (desain berbantuan 

komputer), yang merupakan Tool pemetaan 3D berbasis vektor, untuk gambar teknis, termasuk 

diagram dan desain yang rumit seperti: 

 Rencana bangunan 

 Desain infrastruktur 

 Skema listrik 

 Model produk 

Gambar teknik harus sangat tepat. Insinyur membuat desain mereka sesuai dengan spesifikasi 

terperinci dengan perangkat lunak CAD khusus, seperti CorelCAD. Bahkan model CAD yang paling 

rumit pun dapat diskalakan dengan mulus karena dibuat menggunakan gambar vektor. Dari 

kedirgantaraan hingga desain tekstil, kemahiran dalam gambar teknik berbasis vektor diperlukan di 

semua spesialisasi teknik. 

2.13 GAMBAR VEKTOR DAN AKAN TETAP ADA 

Banyak industri dan pekerjaan membutuhkan pengetahuan tentang desain berbasis vektor. Baik itu 

fungsi inti dari pekerjaan Anda, seni vektor menyenangkan untuk dipelajari dan sepadan dengan 

waktu yang diperlukan untuk mempelajari dasar-dasarnya. Setelah beberapa pengalaman langsung 

dengan gambar vektor, membuat desain untuk semua jenis penggunaan , mulai dari ikon situs web 

dan logo merek hingga font, papan reklame, barang dagangan, dan banyak lagi. Jelajahi jenis gambar 

yang lebih spesifik yang dapat Anda buat menggunakan perangkat lunak berbasis vektor. 

2.14 LOGO 

Karena skalabilitas berbasis matematika mereka, sebagian besar desainer logo menggunakan 

program desain vektor untuk membuat file AI, CDR, EPS, PDF, dan SVG. Logo vektor berisi kurva, 

garis, titik, dan berbagai bentuk. Misalnya, saat Anda melihat logo perusahaan dan memperbesarnya, 

Anda dapat melihat bahwa garisnya tetap tajam dan bersih berapa pun ukurannya: 
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Jadi, Anda dapat mendesain logo yang terlihat kecil di layar Anda tetapi dapat meledak hingga tak 

terbatas tanpa kehilangan kualitas. Anda dapat membuat logo vektor yang menakjubkan pada label 

pakaian anak seperti bangunan kota yang besar. Ini juga berarti Anda bisa konsisten dan dramatis, 

apa pun permukaan atau materi pemasarannya. 

Misalnya, jika Anda mendesain label pakaian yang menampilkan logo, menggunakan vektor 

memastikan Anda dapat menambahkan desain yang sama ini ke item lain tanpa distorsi: 

Gambar vektor harus dimiliki untuk bordir logo, dan mesin membutuhkan peta gambar yang tepat 

untuk mentransfer logo ke tekstil. Setelah Anda membuat desain vektor, mudah untuk mengubah 

warna, orientasi, atau posisinya sesering yang diperlukan. Anda juga dapat mendesain banyak variasi 

pada satu tema dan membuat masing-masing terlihat berbeda. 

2.15 BALIHO 

Gambar-gambar di papan reklame menggunakan rumus matematika teknologi vektor untuk 

memungkinkan gambar menjadi sebesar itu tanpa kehilangan kualitas. Perangkat lunak gambar 

vektor memungkinkan seorang desainer untuk membuat gambar di komputer di rumah untuk 

digunakan dalam berbagai ukuran. 

Jika ini adalah gambar raster, papan reklame atau tampilan kemungkinan akan berbintik, berpiksel, 

dan sulit dilihat. Teknologi yang sama yang membuat logo sederhana dan memungkinkannya 

berukuran berapa pun sama dengan yang digunakan untuk tampilan besar di hampir semua 

permukaan. 

2.16 SELEBARAN 

Sama seperti seni vektor yang ideal untuk desain skala besar, itu juga berguna untuk pekerjaan skala 

kecil seperti selebaran. Logo yang sama pada papan reklame atau membentang di gedung pusat kota 

adalah logo yang sama yang dapat Anda gunakan pada pamflet, sebagai ikon kecil di majalah, sebagai 

tanda air pada poster, atau sebagai elemen yang menakjubkan dari tata letak apa pun, terutama di 

media cetak , di mana kerenyahan dan ketajaman harus tepat. 

Berikut adalah contoh tampilan pamflet ini: 
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2.17 BARANG BERMEREK 

Karya seni vektor berkualitas tinggi adalah suatu keharusan ketika memproduksi desain non-piksel 

pada barang dagangan merek seperti pakaian, tas, mug, pena, dan kaos. Karena seni vektor 

memberikan garis yang lebih tajam dan bersih, ini adalah jenis file yang ideal untuk pengubahan 

ukuran yang tajam. Berikut ini contoh tampilan barang dagangan bermerek: 

memulai sebagai desainer atau pemasar yang perlu mengembangkan desain serbaguna untuk 

kampanye, desain vektor adalah tempat untuk memulai. Salah satu alasannya, tentu saja, adalah 

fleksibilitasnya yang luar biasa. Teknologi gambar vektor yang sama berarti Anda dapat 

menggunakannya untuk membuat karya seni yang indah meskipun Anda belum pernah menganggap 

diri Anda seorang seniman sebelumnya. 

Ada berbagai Tool perangkat lunak, dan beberapa membutuhkan lebih banyak waktu untuk 

membiasakan diri daripada yang lain. Saat memilih perangkat lunak vektor, pastikan Tool tersebut 

dapat dengan mudah mengekspor vektor ke web. Itu berarti itu menghasilkan file yang kompatibel, 

seperti SVG, yang digunakan untuk membuat halaman web.  

 Bekerja dengan baik dengan tablet 

 Sederhanakan ilustrasi (ideal untuk mereka yang bukan seniman freehand) 

 Menyediakan kontrol tipografi 

 Mendukung berbagai format file 

2.18 MEMILIH PERANGKAT LUNAK GAMBAR VEKTOR YANG TEPAT 

Pada tahun 1963, ilmuwan komputer dan perintis internet Ivan Sutherland menciptakan perangkat 

lunak vektor pertama: Sketchpad. Sketchpad adalah terobosan dalam industri grafis komputer, dan 

membuka jalan bagi perangkat lunak desain berbantuan komputer dan grafis vektor modern. 

Sekarang, ada banyak pilihan perangkat lunak vektor yang tersedia. Baik Anda membuat seni vektor 

untuk bisnis atau kesenangan, Anda harus meluangkan waktu untuk mempertimbangkan editor 

vektor mana yang tepat untuk Anda. 

https://www.coreldraw.com/en/learn/guide-to-vector-design/vector-art-in-business/
https://www.coreldraw.com/en/learn/guide-to-vector-design/vector-art-in-business/
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2.18.1 TIPE PERANGKAT 

Sebagian besar perangkat lunak gambar vektor dirancang untuk laptop dan komputer desktop 

daripada tablet dan ponsel cerdas, tetapi opsi tersedia apa pun perangkat yang Anda gunakan. 

Beberapa merek menawarkan versi desktop dan seluler dari perangkat lunak mereka, dengan versi 

seluler yang lebih mendasar, dengan lebih sedikit fitur dan kemampuan. Pastikan perangkat lunak 

pilihan Anda kompatibel dengan perangkat Anda sebelum membeli. 

2.18.2 SISTEM OPERASI 

Sebagian besar nama besar seperti CorelDRAW dan Illustrator akan berfungsi di Windows atau Mac 

OS, tetapi ada lebih sedikit pilihan perangkat lunak untuk Chrome OS, Linux, dan sistem operasi lain 

yang kurang umum. Platform berbasis browser, seperti Canva, mungkin merupakan opsi terbaik jika 

Anda memerlukan perangkat lunak yang berfungsi di Chromebook atau perangkat serupa. Fungsi dan 

fitur perangkat lunak harus serupa di berbagai sistem operasi, tetapi beberapa elemen mungkin 

berbeda, seperti pintasan keyboard. 

2.18.3 HARGA DAN MODEL BERLANGGANAN 

Berbagai poin harga dan model langganan tersedia tergantung pada perangkat lunak vektor mana 

yang Anda pilih. Pembelian satu kali akan lebih mahal di muka, memastikan harga tetap dan 

menyediakan akses tanpa batas. Ingatlah bahwa pembelian satu kali kemungkinan memberi Anda 

versi perangkat lunak tertentu yang mungkin tidak menyertakan pembaruan perangkat lunak biasa. 

Alternatifnya, pemimpin industri seperti CorelDRAW dan Adobe menawarkan model langganan 

untuk perangkat lunak desain vektor mereka. Model ini melibatkan biaya awal yang lebih rendah 

diikuti dengan pembayaran rutin bulanan atau tahunan. Langganan perangkat lunak biasanya 

memberi pengguna akses ke pembaruan perangkat lunak, memungkinkan mereka menggunakan 

versi terbaru perangkat lunak tanpa membayar ekstra. 

2.18.4 BERBAYAR VS. SUMBER TERBUKA 

Cobalah editor vektor sumber terbuka atau gratis jika Anda seorang pemula yang ingin mencoba seni 

vektor tanpa mengeluarkan biaya apa pun. Ada banyak editor gambar gratis berbasis browser dan 
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berdiri sendiri yang tersedia saat ini. Perangkat lunak vektor gratis seperti Canva, Krita, dan Inkscape 

memberi Anda fungsi desain grafis dasar. Beberapa dari opsi “gratis” ini menempatkan fitur-fitur 

canggih di belakang paywall. Opsi berbayar seperti CorelDRAW dan Illustrator memiliki lebih banyak 

fitur dan kemampuan yang lebih canggih. 

2.18.5 SET FITUR 

Sebelum berinvestasi dalam perangkat lunak desain vektor, pastikan perangkat lunak itu memiliki 

fitur yang Anda butuhkan untuk membuat karya seni yang ingin Anda buat. Beberapa Tool standar di 

sebagian besar opsi perangkat lunak seni vektor, tetapi beberapa program memiliki fitur unik yang 

satu dengan yang lainnya tidak akan sama. 

Sebagai contoh, Tool PowerTRACE CorelDRAW sangat bagus untuk membuat vektor gambar — Tool 

sebanding Illustrator disebut jejak gambar. CorelDRAW menawarkan Tool kolaborasi online untuk 

memfasilitasi pengerjaan proyek sebagai sebuah tim — perangkat lunak terkemuka lainnya tidak 

memiliki fitur ini. 

2.19 KEMUDAHAN PENGGUNAAN UNTUK PEMULA 

Jika Anda baru mengenal gambar vektor, perangkat lunak vektor gratis mungkin merupakan pilihan 

yang baik untuk Anda, karena biasanya lebih sederhana dan lebih mudah dipelajari oleh pemula. 

Adobe Illustrator adalah perangkat lunak yang kuat, tetapi dapat memiliki kurva belajar yang curam, 

terutama bagi pengguna yang belum pernah menggunakan perangkat lunak Adobe lainnya. Banyak 

yang menganggap CorelDRAW lebih mudah dipelajari dan didukung dengan banyak konten tutorial 

yang bermanfaat.  

2.20 GARIS VEKTOR 

Gambar vektor di dunia seni digital karena dibuat dari titik dan garis yang ditentukan secara 

matematis — berbeda dengan gambar raster , yang dibuat dari peta piksel berwarna. Karena cara 

datanya disimpan, gambar vektor dapat diskalakan ke ukuran besar tanpa kehilangan kualitas. 

Dapat menjadi tantangan untuk sepenuhnya memahami implikasi praktis dari bentuk seni berbasis 

matematis. Dalam pekerjaan sehari-hari mereka, desainer grafis, seniman, dan ilustrator biasanya 

tidak melihat matematika yang terjadi di balik layar dalam perangkat lunak seni vektor mereka. 

Namun, tetap penting untuk memahami cara kerja program ini. Seperti halnya kerajinan apa pun, 

mempelajari dasar-dasarnya dapat membantu Anda menjadi seniman yang lebih berpengetahuan 

luas. 

gambar vektor dibuat dari serangkaian persamaan matematika yang dibaca dan ditampilkan oleh 

perangkat lunak gambar vektor Anda setiap kali Anda membuka file vektor. Persamaan ini 

menentukan berbagai titik pada bidang kartesius, dan garis menghubungkan titik-titik tersebut, 

membuat gambar. 

Ilustrasi vektor dapat memiliki detail yang sangat banyak, termasuk detail yang rumit, bayangan yang 

realistis, dan garis yang rumit. Tapi tidak peduli seberapa rumit dan rumitnya desain vektor Anda, 

pada dasarnya itu masih terdiri dari kumpulan titik dan garis pada sebuah bidang. 
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2.21 CARA KERJA GARIS VEKTOR 

Garis vektor, juga disebut sebagai "jalur", dibentuk dengan menghubungkan dua atau lebih titik 

diskrit. Titik-titik ini menentukan awal dan titik akhir dari sebuah garis, dan mereka juga dapat 

ditempatkan di sepanjang garis jika Anda berencana untuk mengubah arah atau kurva. Dengan Tool 

dan elemen vektor ini, mudah untuk membuat garis dan kurva yang ditentukan dengan tepat: 

2.22 POIN VEKTOR 

Titik vektor, juga dikenal sebagai simpul vektor, adalah blok bangunan paling dasar dari gambar 

vektor. Titik-titik ini disimpan dalam file vektor sebagai data matematika menggunakan geometri 

koordinat. Saat Anda menambahkan titik vektor ke seni Anda, lokasinya ditentukan pada sumbu x/y 

pada bidang kartesius, dan koordinat tepatnya disimpan saat Anda menyimpan file. Garis dan bentuk 

vektor dibuat menggunakan titik, jadi semua seni vektor seluruhnya terdiri dari titik terlepas dari apa 

yang Anda desain. 

Meskipun data gambar vektor disimpan sebagai titik, Anda tidak hanya melihat titik saat membuka 

file seni vektor. Poin saja tidak akan dapat membuat gambar vektor seperti yang biasa Anda lihat. Ini 

menggabungkan titik bersama dengan garis yang memungkinkan anda membuat desain vektor. Garis 

vektor dapat terbuka atau tertutup, dengan garis terbuka menghubungkan dua titik dan garis 

tertutup dimulai dan diakhiri pada titik yang sama. Anda dapat membuat gambar yang jauh lebih 

detail dan kompleks dengan menggabungkan beberapa garis vektor. Garis vektor bisa lurus atau 

melengkung — jalur vektor melengkung juga disebut kurva Bézier. 

2.23 APA ITU KURVA BÉZIER? 

Kurva Bézier, dinamai menurut nama insinyur Prancis Pierre Bézier , adalah garis lengkung yang 

dapat Anda buat menggunakan perangkat lunak gambar vektor. Seperti garis vektor lurus, kurva 

Bézier didefinisikan menggunakan rumus matematika. Ini berarti kurva Bézier dapat diskalakan tanpa 

batas tanpa kehilangan kualitas, manfaat mendasar dari gambar vektor . 

Satu set dua titik kontrol vektor menentukan titik awal dan akhir kurva. Kedua titik ini juga dapat 

menentukan bentuk kurva secara keseluruhan. Semakin banyak node vektor yang Anda tambahkan 

ke jalur melengkung Anda, semakin Anda dapat memanipulasi bentuk kurva yang tepat atau 

membuat banyak kurva dalam satu baris. Untuk mengubah bentuk kurva vektor, klik dan seret untuk 

menyesuaikan titik pengambilan atau "pegangan" kurva Bézier. Anda dapat menyempurnakan posisi 

titik kontrol vektor dengan tangan bebas atau menggunakan kisi untuk lebih presisi. 

https://www.coreldraw.com/en/learn/guide-to-vector-design/history-of-vector-graphics/
https://www.coreldraw.com/en/learn/guide-to-vector-design/why-should-i-use-vectors/
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2.24 MENGUASAI GARIS VEKTOR 

Membuat bentuk dalam perangkat lunak gambar vektor itu mudah, dan ada beberapa teknik 

berbeda untuk dicoba. Pertama, Anda dapat membuat bentuk secara manual menggunakan titik dan 

garis. Saat Anda menghubungkan beberapa titik dan garis, Anda dapat membentuk bentuk. 

Alternatifnya, sebagian besar program perangkat lunak gambar vektor memiliki Tool bentuk khusus 

yang memungkinkan Anda membentuk bentuk sederhana dengan cepat. Anda akan membahas Tool 

bentuk secara lebih rinci di bawah ini. 

Karena bentuk dibuat dari simpul dan garis, Anda dapat memanipulasinya seperti Anda dapat 

mengedit dan menyesuaikan garis vektor. Cukup klik dan seret tuas kontrol kurva titik atau vektor 

apa pun pada objek Anda untuk menyesuaikan ukuran dan bentuknya. Bentuk sederhana sering 

disebut sebagai primitif geometris. Bentuk dasar ini adalah blok bangunan untuk bentuk yang lebih 

kompleks dan elemen grafis lainnya. 

Seni vektor terbuat dari data matematis dan titik-titik yang diplot pada bidang — inilah yang 

membuat gambar vektor dapat diskalakan tanpa batas sambil menjaga ukuran file tetap kecil dan 

dapat dikelola. Meskipun teknologi ini terdengar rumit, semua perencanaan koordinat yang rumit 

terjadi di balik layar dalam perangkat lunak. Menempatkan dan mengedit bentuk dan objek 

sebenarnya sangat sederhana bagi pengguna yang membuat karya seni di perangkat lunak gambar 

vektor. 

2.25 BENTUK VEKTOR 

 

https://www.coreldraw.com/en/learn/guide-to-vector-design/how-do-vector-graphics-work/
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2.26  PERSEGI PANJANG 

Tool persegi panjang memungkinkan Anda membuat kotak dan persegi panjang. Setelah Anda 

memilih Tool persegi panjang, Anda cukup mengklik kanvas Anda dan menyeret kursor Anda untuk 

membuat persegi panjang. Setelah persegi panjang Anda digambar, Anda dapat menyesuaikan 

ukuran dan dimensi serta menggunakan Tool lain untuk mengubah warna isian, warna kerangka, dan 

ketebalan garis. Sebagian besar editor vektor juga memiliki Tool yang memungkinkan Anda 

membulatkan sudut persegi panjang dengan cepat. 

2.27  ELIPS 

Tool elips dapat membuat lingkaran, elips, dan oval. Biasanya, ada pintasan keyboard yang dapat 

digunakan untuk membantu  mempercepat dalam membuat bentuk lingkaran atau elipse yang 

sempurna saat  anda mengeklik dan menyeret tool elips. Dengan perangkat lunak vektor, Anda dapat 

dengan mudah menskalakan bentuk melengkung seperti elips tanpa mengorbankan kualitas gambar. 

Dan, seperti persegi panjang, Anda dapat membuat warna isian dan kustomisasi batas dengan elips 

apa pun yang Anda buat. 

2.28 POLIGON 

Untuk bentuk yang lebih rumit dan bersisi banyak, Anda dapat menggunakan Tool poligon. Biasanya, 

preset bentuk poligonal bersarang di bawah Tool poligon dalam perangkat lunak vektor. Misalnya, 

CorelDRAW memiliki preset yang mudah untuk bintang, spiral, panah, hati, dan bentuk umum 

lainnya. 

Tool poligon memungkinkan Anda untuk memilih berapa banyak sisi yang akan dimiliki bentuk Anda 

dan apakah semua sisi akan diskalakan atau tidak. Sama seperti Tool bentuk lainnya, Anda dapat 

menyesuaikan poligon secara manual setelah Anda menggambarnya, mengubah ukuran, bentuk, 

warna, dan garis yang tepat agar sesuai dengan visi Anda untuk desain Anda. 

2.29 MULAILAH MEMBUAT SENI VEKTOR 

Dari memilih perangkat lunak desain grafis yang tepat hingga mengembangkan keterampilan yang 

tepat dan menemukan inspirasi seni vektor, setiap keputusan akan memengaruhi kesuksesan Anda di 

masa depan sebagai seniman vektor. Ingatlah tip-tip ini saat Anda mulai membuat seni vektor. 

2.30 MEMILIH PERANGKAT LUNAK GAMBAR VEKTOR YANG TEPAT 

Sulit untuk mengetahui apa yang tidak Anda ketahui – dan itu terutama benar ketika mencoba 

memilih program perangkat lunak untuk sesuatu yang Anda tidak berpengalaman. Seiring waktu, 

Anda akan mengembangkan preferensi, dan perangkat lunak pilihan Anda akan menjadi bagian dari 

proses kreatif Anda. Sementara itu, Anda mungkin menggunakan sedikit trial and error untuk melihat 

apa yang Anda suka. Saat Anda mulai mencoba beberapa program, pertimbangkan: 

 Sistem operasi 

 Harga 

 Fitur 

https://www.coreldraw.com/en/learn/guide-to-vector-design/choosing-vector-software/
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2.31 MENAMBAHKAN DIMENSI KE GAMBAR VEKTOR 

Gambar vektor sangat penting dalam desain digital, di mana klien dapat dengan mudah 

menggunakan kembali file yang sama untuk proyek skala kecil dan besar. Anda telah menetapkan 

nilai format serbaguna ini di bab-bab sebelumnya. Tetapi untuk desainer pemula, jenis file ini 

mungkin tampak terbatas—pada pandangan pertama—untuk sekadar menggambar garis dan bentuk 

, lalu menerapkan warna dasar. 

Dalam melihat lebih dekat-Anda akan menemukan bahwa ada lebih banyak kedalaman yang tersedia 

dalam program desain yang dapat menghidupkan seni vektor Anda. Dan itu dapat diakses oleh Anda 

melalui Tool isian bentuk. Pada artikel ini, anda akan membahas empat Tool pengisi utama yang 

digunakan oleh desainer grafis dan diakhiri dengan teknik bonus yang akan membuat karya seni 

vektor Anda menonjol. 

2.32 WARNA 

Warna adalah teknologi isian bentuk pertama dan paling dasar yang tersedia dalam program desain 

grafis. Bahkan pengguna biasa dengan cepat mengenali Tool pengisi warna. Ini biasanya diwakili oleh 

simbol ember cat. Isi seragam adalah istilah yang digunakan untuk menerapkan satu warna ke objek 

vektor. Warna dipilih dari carikan atau dengan menggunakan Tool pipet. Eyedropper dapat memilih 

warna yang tepat dari mana saja di layar Anda tanpa memerlukan kode warna. 

Dalam artikel anda sebelumnya, anda membahas teori warna secara mendalam. Anda menunjukkan 

betapa sederhananya menggunakan skema warna yang dipilih dengan cermat dapat secara signifikan 

memengaruhi desain Anda—bahkan memancing emosi tertentu. Ilmu di balik teori warna membantu 

desainer memilih skema warna yang saling melengkapi dan kontras untuk mencapai tujuan yang 

berbeda. Baik menggunakan kode warna RGB, Hex, CMYK, atau Pantone, ada hikmah di balik 

pemilihan palet yang tepat dari jutaan corak warna yang tersedia. Tetapi ada seluruh dunia di luar 

pencocokan warna dasar dalam desain vektor Anda–yang membawa anda ke opsi isian bentuk yang 

lebih canggih. 

https://www.coreldraw.com/en/learn/guide-to-vector-design/vector-lines/
https://www.coreldraw.com/en/learn/guide-to-vector-design/vector-shapes/
https://www.coreldraw.com/en/learn/guide-to-vector-design/choosing-vector-software/
https://www.coreldraw.com/en/learn/guide-to-vector-design/understanding-color-basics/
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2.33 GRADIEN 

Gradien warna adalah efek isian bentuk yang lebih canggih yang dapat mulai memberikan tampilan 

3D. Isian gradien berubah secara bertahap dari satu warna ke warna lainnya. Seringkali, warnanya 

berada dalam keluarga warna yang sama atau memudar menjadi putih. Hal ini dapat memunculkan 

tampilan matahari menyinari suatu objek atau dapat digunakan untuk menciptakan efek bayangan 

yang meyakinkan. Tapi itu tidak harus terbatas pada dua warna. Perangkat lunak desain grafis 

berkualitas dapat memungkinkan pengguna untuk memasukkan warna yang tak terhitung jumlahnya 

ke dalam isian gradien. 

Setelah Anda memilih warna, ada banyak opsi sederhana untuk memodifikasi efek isian gradien pada 

objek, termasuk beralih antara gradien warna linier dan radial. Anda dapat men-tweak gradien Anda 

lebih lanjut dengan presisi sempurna dengan menyesuaikan sudut, distribusi, dan penempatannya. 

Manfaat menggunakan gradien dengan file vektor mencakup ukuran file yang kecil dan kemudahan 

mengubah warna serta properti lainnya 

 

 

 

https://www.coreldraw.com/en/learn/guide-to-vector-design/vector-file-types/
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2.34 POLA 

Isi pola adalah Tool isian terakhir dan sejati yang dapat menghadirkan kerumitan pada desain vektor 

Anda. Juga disebut pola vektor, ini bisa dianggap sebagai wallpaper di sebuah ruangan. Pola 

mengambil elemen tunggal dan mengulanginya. Anda dapat menerapkan pola ke objek dalam file 

vektor Anda untuk desain yang menyenangkan dan berStyle. Desainer sering menggunakan pola 

untuk menerapkan branding pada barang dagangan atau menambahkan tekstur ke objek statis, 

membuatnya tampak lebih realistis. Kemungkinan dengan efek isian ini tidak terbatas. Anda dapat 

membuatnya tetap sederhana dengan garis dan bentuk atau membuat pola yang sangat rumit. 

Banyak program desain grafis hadir dengan beberapa isian pola yang telah dimuat sebelumnya untuk 

dipilih, tetapi Anda juga dapat membuatnya sendiri. Membuat pola Anda sendiri dapat berguna saat 

menggunakan Tool ini untuk menghasilkan karya seni bermerek. Tool pengisi ini sering dilengkapi 

dengan properti yang dapat disesuaikan untuk mengubah ukuran dan sudut untuk menghasilkan efek 

yang diinginkan. Isian pola vektor memungkinkan penyesuaian cepat pada warna dan skala yang 

tidak mengganggu kualitas gambar Anda. 

 

2.35 TRANSPARANSI 

Teknik terakhir yang digunakan untuk menyempurnakan desain vektor adalah transparansi gambar. 

Meskipun secara teknis bukan jenis bentuk yang mengisi dengan sendirinya, transparansi adalah 

konsep penting dalam proyek desain apa pun. Transparansi mengurangi opasitas suatu objek 

sehingga Anda dapat melihatnya, mengungkapkan objek apa pun yang ada di belakangnya. Ini 

memberikan ilusi objek berlapis dan menambah dimensi pada desain Anda. Objek dengan opacity 

penuh tidak memiliki transparansi dan karenanya mengaburkan objek apa pun di belakangnya dari 

pandangan. 

Perangkat lunak grafis memungkinkan desainer untuk menyesuaikan pengaturan transparansi pada 

setiap objek vektor. Pengaturan paling sederhana memberi Anda skala dari nol hingga 100 persen 

untuk mengatur transparansi gambar. Seringkali, ada pengaturan tambahan yang lebih kompleks 

dalam Tool transparansi yang dapat digunakan untuk membuat efek kompleks. Opsi standar 

meliputi: 

 Transparansi seragam 

 Transparansi air mancur 
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 Transparansi pola vektor 

 Transparansi pola bitmap 

2.36 TOOL DAN TEKNOLOGI YANG DIBUTUHKAN UNTUK MEMBUAT SENI VEKTOR 

Membuat seni dalam media digital, seperti vektor, membutuhkan Tool digital. Minimal, Anda 

memerlukan perangkat yang kompatibel dengan perangkat lunak desain grafis Anda untuk membuat 

seni vektor. Untuk sebagian besar, ini berarti PC atau Mac berbasis Windows. Jika Anda membeli 

perangkat baru, perhatikan baik-baik kartu grafis dan properti tampilan dan pilih perangkat dengan 

prosesor multi-core untuk pengalaman yang cepat dan responsif. 

Pertimbangkan untuk menambahkan perangkat seluler atau periferal untuk meningkatkan proses 

kreatif Anda agar lebih fleksibel. Laptop 2-in-1 dengan layar sentuh dan stylus gambar dapat 

membuat Anda tetap kreatif saat bepergian. Dan Tool khusus seperti alas gambar, pemindai flatbed, 

dan perToolan fotografi digital dapat membantu Anda mengubah karya seni fisik Anda menjadi 

vektor untuk dunia digital. 
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SOAL LATIHAN 

1. Sebutkan hal-hal yang dipelajari didalam seni vector dan bidang apa saja 

2. Apa yang membedakan antara bentuk vector dan garis vector 

3. Gambarkan bentuk-bentuk vector yang dapat dimodifikasi baik dari segi pola maupun 

warna  

4. Sebutkan beberapa tool yang dapat dipergunakan untuk memodifgikasi atau 

memanipulasi bentuk vector ! 

5. Dapatkan bentuk bitmap dijadikan sebagai bentuk vector?Jelaskan alasannya 
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BAB 3 
VEKTORISASI GAMBAR 

 

 Dalam bab ini membahas bentuk – bentuk obyek vectorisasi dengan mengubah bentuk bitmap 

kedalam  bentuk vector 

 Mahasiswa diharapkan dapat merubah atau memodifikasi bentuk obyek bitmap atau pixel 

kedalam obyek yang berbasis vector 

 

Sebagai calon desainer grafis atau ilustrator, maka tahu pentingnya memiliki file gambar yang tajam, 

jelas, dan serbaguna. Saat memulai dari awal, umumnya mudah untuk mendesain dalam format file 

vektor. Namun terkadang, klien meminta Anda untuk memasukkan file yang sudah ada ke dalam 

desain Anda. Jika Anda beruntung, itu akan menjadi file yang kompatibel, tetapi format yang Anda 

berikan untuk bekerja seringkali memerlukan sedikit penyesuaian. Saat itulah Anda perlu mengetahui 

lebih banyak tentang proses vektorisasi gambar. 

Apa yang dimaksud dengan vektorisasi gambar? Ini adalah konversi file sederhana, tetapi untuk 

membantu Anda lebih memahami prosesnya, anda akan membagi dua kategori format file gambar. 

Gambar raster dapat digunakan dalam banyak skenario, tetapi dapat menjadi berpiksel atau buram 

saat diubah ukurannya. Hilangnya kualitas gambar ini berasal dari jenis file, yang menyimpan data 

gambar sebagai piksel. 

Gambar vektor, di sisi lain, menyimpan data yang sama sebagai sekumpulan titik, garis, atau bentuk 

yang ditentukan secara matematis. Proporsi matematis memungkinkan skalabilitas tanpa kehilangan 

kualitas gambar, membuat gambar vektor paling cocok untuk sebagian besar aplikasi desain grafis. 

Sebelum melompat ke proses bagaimana memvektorkan gambar, mari anda segera memeriksa 

kembali manfaat menggunakan vektor. Menggunakan format Vektor memungkinkan Anda membuat 

gambar mencolok yang dapat diskalakan dengan kualitas nol. Dengan format vektor, klien Anda 

dapat menggunakan file desain yang sama untuk proyek besar, termasuk baliho dan spanduk, dan 

proyek kecil seperti sulaman pakaian dan kartu nama. 

Meskipun pengubahan ukuran tidak diperlukan, ada aplikasi lain yang hanya mendukung gambar 

vektor. Mesin bordir, misalnya, memerlukan gambar vektor untuk mengonfigurasi peta jahitan 

dengan benar. Gambar vektor yang dapat diskalakan (SVG) juga diperlukan untuk mesin cetak dan 

potong, seperti pemotong laser pribadi Cricut, memungkinkan mesin untuk membaca dan 

mengeksekusi informasi file secara akurat. 

Sebagai seorang desainer, Anda akan bekerja dengan berbagai format file. Beberapa format gambar 

raster yang paling umum adalah: 

 JPEG 

 BMP (Bitmap) 

 PNG (Gambar Jaringan Portabel) 

 GIF (Format Pertukaran Gambar) 

 TIFF (File Format Gambar Bertanda) 

https://www.coreldraw.com/en/learn/guide-to-vector-design/scalable-vector-graphics/
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Meskipun file gambar ini umum, ada beberapa batasan. File raster cenderung memiliki ukuran file 

yang besar karena data gambar disimpan dalam jutaan piksel per gambar. Itu sebabnya foto 

profesional cenderung berupa file besar; kualitas yang lebih tinggi berarti lebih banyak piksel. File 

besar dapat membatasi penyimpanan dan kemampuan berbagi dan membutuhkan kecepatan 

pemrosesan komputer yang ditingkatkan, yang membuat gambar raster berkualitas tinggi menjadi 

sulit untuk dikerjakan. 

Alternatifnya, saat Anda menggunakan format gambar vektor, data yang disimpan jauh lebih sedikit 

karena gambar diubah menjadi rumus berbasis matematika, membuat file jauh lebih kecil dan 

portabel. 

Seringkali, sebagai desainer vektor , aset gambar raster perlu diubah menjadi format vektor. Ini 

membuat file dapat digunakan dalam desain Anda dan lebih praktis untuk aplikasi multifungsi. 

Meskipun memvektor foto yang sangat detail mungkin tidak selalu praktis, Anda dapat membuat 

gambar vektor yang dapat digunakan dengan mengekstraksi aspek terbaik dari gambar tersebut. 

3.1 MEMBUAT VEKTOR GAMBAR 

Vektorisasi gambar umumnya dikenal sebagai pelacakan vektor. Pelacakan vektor memerlukan Tool 

perangkat lunak untuk mengonversi elemen gambar raster berbasis pixel menjadi serangkaian garis 

dan bentuk yang diplot secara matematis–data yang diperlukan untuk file vektor. 

CorelDRAW menyediakan Tool yang and butuhkan untuk membuat vektor gambar. Berikut adalah 

panduan langkah secara sederhana bagaimana cara mengonversi gambar pixel ke bantuk  gambar 

vektor. TRACE membuat proses vektorisasi gambar menjadi sederhana, akurat, dan dapat 

disesuaikan, menggunakan Tool kecerdasan buatan untuk membantu Anda menyelesaikan 

pekerjaan. 

3.2 PROSES POWER TRACE PADA IMAGE 

Berikut langkah untuk merubah bentuk gambar pixel atau bitmap menjadi bentuk vector 

 Import gambar dalam benuk pixel atau bitmap, aktifkanmenu File pilih Import 

https://www.coreldraw.com/en/learn/guide-to-vector-design/raster-vs-vector/
https://www.coreldraw.com/en/learn/guide-to-vector-design/


30 
 

 

Gambar : 3. 1( Import image ) 

 Pilih gambar yang diinginkan,  

 Aktifkn menu Bitmap, pilih Outline Trace 

 Pilih salah satu bentuk Trace yang di inginkan 

 

Gambar : 3. 2 ( Piliah menu Trace ) 

 Misalnya kita pilih “ Clipart dan akan tampil gambar seperti berikut: 
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Gambar : 3. 3 ( pilihan menu Trace , Clipart ) 

 Pengaturan Trace dengan pilihan Clipart 

 

Gambar : 3. 4 ( Power Trace “Clipart “) 

 

 



32 
 

 

Gambar : 3. 5 (Power Trace “ Hight Quality Image ) 

 

Gambar : 3. 6 ( Power Trace “ Line Art ) 
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Gambar : 3. 7 ( Hasil Proses Power Trace ) 

 Selanjutnya tekan “klik Kanan” pilih Ungroup 

 

 

Gambar : 3. 8( Proses UnGroup) 

 Setelah gambar di modifikasi dengan cara di Ungroup, dengan menghilangkan bagian-bagian 

yang tidak diperlukan. ( proses ini hanya berlaku saat gambar pixel  atau bitmap sesudah di 

PowerTrace) 
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Gambar : 3. 8  Proses akhir Power Trace ) 

3.3 QUICK TRACE 

 Digunakan untuk melakukan proses Trace dengan cara yang cepat tanpa ada pengaturan di obyek 

tersebut 

 

Gambar : 3. 9 ( Proses Quick Trace ) 

 

 

Meskipun setiap bitmap mungkin memerlukan perlakuan khusus tersendiri, Anda dapat melihat 

betapa canggih dan mudahnya penggunaan fitur PowerTRACE. Hanya dalam beberapa langkah 

singkat, Anda telah mempelajari cara menggunakan PowerTRACE untuk menghasilkan versi logo 

kompleks yang dilacak secara akurat hanya menggunakan bitmap beresolusi rendah sebagai 
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sumbernya. 

SOAL LATIHAN 

1. Syarat bentuk bitmap atau pixel  dapat dijadikan kedalam bentuk vector dengan 

ketentuan ! 

2. Sebutkan dan jelaskan masing – masing bentuk PowerTrace berserta fungsinya ! 

3. Sebutkan beberapa aplikasi yang dapat mengolah atau merubah bentuk bitmap ke bentuk 

vector dengan cara men tracinng obyek tersebut ! 

4. Apa yang dimakseud dengan Tracing/ Tracer ? 

5. Berikan kekurangan dan kelebihan berubah bentuk bitmap ke bentuk vector dengan cara 

di tracing ! 
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BAB 4 
MEMANIPULASI OBJEK VEKTOR 

 
 

 Dalam bab ini membahas tentang bagaimana cara memanipulasi obyek vector untuk 

menjadikan lebih dari obyek dasar  

 Mahasiswa diharapkan dapat memanipulasi bentuk vector dengan pilihan too yang di sediakan 

dalam aplikasi tersebut, baik dari sisi tataletak, bentuk ,posisi dan komposisi obyek 

 

Mengubah gambar dan memanipulasi objek vektor adalah keterampilan dasar yang diperlukan oleh 

setiap desainer grafis. saat anda terus berlatih dengan perangkat lunak gambar vektor, anda akan 

menemukan bahwa beberapa prinsip yang sama juga dapat diterapkan pada format gambar raster. 

Gambar vektor adalah media yang sempurna bagi para desainer grafis untuk belajar dan mengasah 

keterampilan mereka. Seperti yang telah anda bahas sebelumnya, gambar vektor memiliki cara yang 

unik dan berguna untuk menyimpan objek dan informasi. File vektor menyimpan data, cukup ringkas, 

sebagai rangkaian titik, garis, dan bentuk yang ditentukan secara matematis. Tapi itu lebih jauh dari 

matematika sederhana. 

Objek individu di dalam file vektor disimpan sebagai entitas berbeda yang dapat dimanipulasi secara 

individual. Setiap objek berisi sejumlah properti mandiri yang dapat disesuaikan, termasuk opsi 

warna, transparansi, dan pelapisan. Konsep ini berlawanan langsung dengan format gambar raster . 

Gambar raster dapat dianggap hanya melihat lapisan atas desain, mirip dengan kanvas yang dicat 

dengan hati-hati di mana warna latar belakang dipilih dengan hati-hati untuk menghasilkan 

mahakarya akhir yang diinginkan. Tidak ada jalan kembali dan mengedit lapisan di bawah bagian 

dalam file raster. Jenis file ini menyimpan data gambar sebagai piksel, membuatnya sangat sulit 

untuk memanipulasi objek individu setelah digabungkan 

4.1 BEBERAPA TRANSFORMASI YANG DAPAT DITERAPKAN KE OBJEK? 

memanipulasi objek vektor itu mungkin, mari bahas beberapa Tool yang membantu Anda 

menyelesaikan pekerjaan. Dengan menggunakan instrumen di bawah ini, Anda dapat 

menyempurnakan karya seni vektor Anda, objek demi objek, untuk mendapatkan efek transformasi 

gambar yang diinginkan. Anda akan membahas lima Tool manipulasi gambar dasar: ubah ukuran, 

pangkas, warp, putar, dan miringkan gambar. 

4.1.2 UBAH UKURAN 

Siapa pun yang bekerja dengan gambar digital kemungkinan besar menghadapi kebutuhan untuk 

mengubah ukuran gambar dari waktu ke waktu. Apakah Anda memerlukan ukuran file yang lebih 

kecil untuk berbagi foto melalui email atau ukuran yang lebih besar untuk menampilkan lebih banyak 

detail di halaman web, menyesuaikan ukuran gambar adalah keahlian dasar yang dibutuhkan oleh 

desainer grafis. 

Perangkat lunak gambar vektor membuatnya sederhana dan mudah untuk mengubah ukuran 

gambar dengan tangan atau dengan bidang manual yang memungkinkan Anda menentukan ukuran 

baru dalam piksel, inci, atau persentase. Format vektor lebih unggul dalam hal membuat gambar 

lebih kecil atau lebih besar karena memungkinkan desainer melakukan penyesuaian langsung tanpa 
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distorsi atau penurunan kualitas. 

 

 Langkah untuk merubah ukuran dari obyek vector seperti berikut ini : 

 Tandai obyek tersebut dari salah satu sudut gambar pada kekempat sisi obyek 

 Tekan tombol shift pada keyboard untuk mendapatkan bantuk dan ukuran obyek yang presisi 

atau tanpa menekan shift jika hanya merubah dari satu sisi saja 

 Lepas tombol shift, jika ukuran obyek sudah sesuai 

4.1.3 CROP 

Croping digunakan untuk menghilangkan tampilan obyek baik secara keseluruhan atau sebagian. 

Tool croping hampir ada disetiap aplikasi, baik pengolahan gambar  seperti Corel,Iluistrator,Photosop 

dan yang lainnya, maiupuin dalam program Microsoft yang semuanya memiliki fasilitas croping 

Fungsi dasar lain dari software desain grafis yang digunakan dalam manipulasi gambar adalah crop 

tool. Ini bekerja mirip dengan perangkat lunak pengedit foto dasar apa pun - memungkinkan Anda 

memilih bagian tertentu dari gambar untuk dipertahankan, menghapus bagian yang tidak dipilih yang 

tersisa. 

Tetapi Tool pangkas di dalam program vektor memiliki fitur tambahan yang memungkinkan Anda 

menutupi bagian yang dihapus tanpa penghapusan permanen. Misalnya, pertimbangkan untuk 

menggunakan Tool layer mask sebagai salah satu cara untuk mencapai pengeditan non-destruktif 

atau perubahan yang mudah dipulihkan jika diperlukan. Ini bermanfaat jika Anda ingin 

mempertahankan gambar asli tetap utuh atau melakukan penyesuaian lebih lanjut nanti. 

 

Langkah untuk melalukan proses croping 
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 Import gambar dalam bentuk bitmap kedalam aplikasii corel draw atau ilustrator 

 Aktifkan tool Crop yang ada di sisi kiri 

 Seleksi gambar atau bagian gambar yang akan di hilangkan  

 Tekan enter untuk mengakhiri proses croping 

4.1.4 WARP 

Tool selanjutnya memiliki efek yang menyenangkan dan kreatif. Image warping adalah proses 

mendistorsi sebagian atau seluruh objek. Artinya, Anda dapat mengubah bentuk aslinya untuk 

menciptakan efek yang unik. Misalnya, Tool distorsi dapat mengubah objek lingkaran polos menjadi 

kelopak bunga yang simetris sempurna. Gambar melengkung berguna saat membuat pola dalam 

desain Anda. CorelDRAW menawarkan berbagai Tool distorsi, termasuk efek dorong dan tarik, 

ritsleting, dan twister. 

 

Langkah untuk membuat efek Warp dalam CorelDraw adalah 

 Buat obyek atau import obyek 

 Pilih  tool efek interaktif Distort 

 Pilih bentuk distort ( Push  and Pull , Twister dan Zipper ) 

 Gerakkan Tool tersebut pada obyek kemudian gerakkan sesuai efek yang dipilih 

4.1.5 ROTATE 

Jika Anda belum cukup siap untuk melengkungkan objek, mari kembali ke cara yang lebih sederhana 

untuk membentuk ulang gambar. Semua perangkat lunak gambar vektor dapat memutar gambar. Ini 

adalah persyaratan dasar yang cukup sering digunakan oleh desainer. Dalam bentuknya yang paling 

sederhana, seniman dapat memutar gambar di seandar titik pivot tertentu dengan tangan. 

Alternatifnya, desainer dapat menentukan jumlah derajat untuk penyesuaian yang lebih tepat. 

CorelDRAW memiliki pengaturan opsional cerdas yang dapat digunakan untuk menjentikkan hingga 

15 derajat saat menahan tombol kontrol saat Anda memutar objek. Ini sangat berguna ketika Anda 

ingin memutar dengan cepat sejumlah derajat standar tertentu, seperti 45, 90, atau 180. 
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Rotasi yang ada di CorelDraw tidak tersedia khusus Tool atau tool untuk melakukan rotasi, melainkan 

tool Rotasi akan tampil pada saat melakukan kik 2 kali pada obyek tersebut. Lain degan Ilustrator, 

untuk tool rotasi sudah ada tool tersendiri atau program- program yang lain 

Untuk melakukan proses rotasi caranya 

 Tandai atau klik  obyek atau gambar 2 kali 

 Setelah tampil simbol atau tanda rotasi seperti pada gambar 4.4 

 Lakukan putaran secara searah jarum jam atau sebaliknya 

 Klik sekali untuk mengembalikan bentuk tool seperti semula 

4.1.6 SKEW 

Tool transformasi gambar dasar terakhir anda untuk desainer grafis adalah fitur gambar miring. Tool 

ini mendistorsi gambar dengan menerapkan miring ke objek, membentuk ulang gambar. Ini bisa 

sangat berguna untuk menambah perspektif. Misalnya, saat membuat mock-up sampul buku dalam 

program desain grafis, Anda harus memiringkan gambar sampul persegi panjang agar pas dengan 

bentuk trapesium sampul depan buku. 

 

Untuk perintah Skew, langkahnya sama seperti proses rotasi, yaitu: 

 Tandai atau klik  obyek atau gambar 2 kali 

 Setelah tampil simbol atau tanda Skewi seperti pada gambar 4.5 

 Lakukan pergerakan kekanan  atau ke kiri atau sebaliknya 

 Klik sekali untuk mengembalikan bentuk tool seperti semula 

4.1.7 WELD 

bentuk manipulasi obyek dengan cara menggabungkan dan menyatukan beberapa obyek menjadi 
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satu kesatuan yang utuh. Dalam penerapan teknik weld, langkah awalnya dengan membuat obyek 

dasar 2 bentuk shape yang sama atau berbeda dengan posisi saling menimpal, tidak bersinggungan.  

 

Bnetuk Weld atau penggabugan  dan penyatuan dua obyek atau lebih baik sama atau berbeda 

menjadi satu kesatuan yang utuh. Untuk melakukan Weld langkah yang harus dilakukan sebagai 

berikut: 

 Buat dua obyek dasar ( Shape ) atau lebih sama atau berbeda 

 Dan kedua obyek tersebut harus saling bertumpuk 

 Seleksi ke dua obyek dasar tersebut 

 Aktifkan menu Arrange, Shaping 

 Pilih Weld 

 Pilih salah satu obyek dasar ( bebas ) 

 Danhasilnya seperti yang terlihat pada gambar 4.6 

4.1.8 TRIM 

Trim merupakan bentuk manipulasi obyek dengan cara memotong bagian obyek tertentum baik 

dengan bentuk dasar atau bentuk kurva dan garis. Ketentuan engunakan Trim , obyekharus saling 

menimpal satu dengan yang lain seperti prosen weld 
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4.1.9 BENTUK TRIM ITU SENDIRI TERBAGI MENJADI 3 SUB BAGIAN, YAITU  

 Simplify,  

 Front minus Back,  

 Back Minus Front 

Untuk melakukan proses Trim, langkahnya sama seperti pada proses Weld yatu dengan cara: 

 Buat dua obyek dasar ( Shape ) atau lebih sama atau berbeda 

 Dan kedua obyek tersebut harus saling bertumpuk 

 Seleksi ke dua obyek dasar tersebut 

 Aktifkan menu Arrange, Shaping 

 Pilih Weld 

 Pilih salah satu obyek dasar ( bebas ) 

 Dan hasilnya seperti yang terlihat pada gambar 4.7 

4.1.10 INTERSECTION 

Intersection dalam manipulasi obyel digunakan untuk mengambil irisan dari dua bua obyek. baik 

sama atau berbeda. 

 

4.1.11 BOUNDARY 

Fungsi dari Boundary sama seperti dalam  weld, yaitu menggabungkan beberapa obyek manjadi satu 

4.2 PATHFINDER 

Istilah PathFinder terdapat pada Ilustrator yang di dalamnya bersisi tool manipulasi seperti yang 

terdapat dalam program CorlDraw, seperti Tim,Weld,Intersect. Tetapi di Ilustrator jauh lebih lengkap 

untuk pilihan manipulasinya. Dibandingkan dengan CorelDraw. Tetapi padasarnya sama untuk teknik 

dan cara menjalankannya. 
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Bentuk PathFinder terbagi menjadi dua panel bagian dalam memanipulasi obyek dasar ( Shape ), 

yaitu Shape Mode dan PathFinder itu sendiri. Bagian Dari Shape Mode adalah 

 Unite 

 Minus Front 

 Intersect 

 Exclude 

4.3 SEDANGKAN BAGIAN DARI PATHFINDER ADALAH: 

 DEvide 

 Trim 

 Merge 

 Crop 

 Outline 

 Minus Back 

4.3.1 UNITE 

Fungsi Unite yang ada pada aplikasi Ilustrator berfungsi sama dengan proses Weld yang ada di 

Coreldraw. Berikut langkahnya: 

 Buat dua obyek yang sama atau berbeda 

 Posisikan saling bertumpuk satu dengan yang lainya ke dua obyek tersebut 

 Aktifkan menu Path Finder 

 Pilih Tool tab “ Unite” 

 

4.3.2 MINUS FRONT 

Minus Front difungsikan untuk memotong obyek yang ada dibelakangnya, fungsi minus Front 

meruoakan bagian dari proses “Trim “ .Langkah untuk membuat proses Minus Front: 

 Buat dua obyek yang sama atau berbeda 

 Posisikan saling bertumpuk satu dengan yang lainya ke dua obyek tersebut 

 Aktifkan menu Path Finder 

 Pilih Tool tab “Minus Front” 
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4.3.3 EXCLUDE 

Exclude digunakan untuk membuat irisan atau memotong pada bagian obyek. Berikut untuk langkah 

pembuatan proses Exclude 

 Buat dua obyek yang sama atau berbeda 

 Posisikan saling bertumpuk satu dengan yang lainya ke dua obyek tersebut 

 Aktifkan menu Path Finder 

 Pilih Tool tab Exclude” 

 

 

 

 

4.3.4 DIVIDE 

Divide digunakan untuk memisahkan obyek yang bertumpuk setelah diproses dengan menggunakan 

menu. Berikut langkah untuk membuat proses divide 

 Buat dua obyek yang sama atau berbeda 

 Posisikan saling bertumpuk satu dengan yang lainya ke dua obyek tersebut 

 Aktifkan menu Path Finder 

 Pilih Tool tab “Devide” 
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4.3.5 TRIM 

Trim digunakan untuk memotong bahian obyek tertentu dari obyek yang menjadi targetnya, 

Fungsinya sama seperti Minus Front yang merupakan bagian dari Trim.Berikut langkah 

pembuatannya: 

 Buat dua obyek yang sama atau berbeda 

 Posisikan saling bertumpuk satu dengan yang lainya ke dua obyek tersebut 

 Aktifkan menu Path Finder 

 Pilih Tool tab “Trim” 

4.3.6 MERGE 

Merge digunakan untuk menggabungkan dua obyek atau lebih untuk disatukan menjadi satu bagian 

yang utuh, Langkah pembuatannya: 

 Buat dua obyek yang sama atau berbeda 

 Posisikan saling bertumpuk satu dengan yang lainya ke dua obyek tersebut 

 Aktifkan menu Path Finder 

 Pilih Tool tab “Merge” 

4.3.7 CROP 

Crop berfungsi untuk mengkrop atau menghilangkan bagian obyek dengan bagian tertentu supaya 

tidak ditampilkan.Langkah pembuatannya 

 Buat dua obyek yang sama atau berbeda 

 Posisikan saling bertumpuk satu dengan yang lainya ke dua obyek tersebut 

 Aktifkan menu Path Finder 

 Pilih Tool tab “Crop” 
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4.4  DENGAN MENGGUNAKAN EFEK 

4.4.1 EFEK BLEND 

Blend digunakan untuk menggandakan obyek dengan cara menempatkan 2 obyek yang sama atau 

berbeda dengan jarak tertentu dengan jumlah yang di inginkan. proses belnd hampir sama dengan 

cara mengkloning atau menggandakan obyek dengan jarak dan jumah tertentu. 

Untuk memberikan efek Blend, berikut untuk langkahnya 

 Buat 2 obyek yang sama atau berbeda dengan jarak tertentu ( tidak di singgungkan atau di 

tumpuk ) 

 Pilih Tool interactive efek Blend pada toolbox 

 Tandai salah satu obyek dasar ( shape ) tersebut 

 Arahkan ujung anak panah pada salah satu  obyek ke obyek yang lain 

 Atur step atau kelipatan blend dengan memilih Property bar pada menu yang tersedia 

 Seperti : Blend Obyek ,Blend Direction, ClockWise Blen atau counter clockWise Blend  

 

4.4.2 CONTOUR 

efek yang memberi bagian-bagian yang sama dengan ukuran atau resolusi yang sebanding di dalam 

objek aslinya.Prosesnya hampir sama dengan efek Blend, bedanya hanya terlatak pada obyek yang di 

efek. untuk Contour hanya satu obyek saja dengan hasil efek berada di posisi Center,Inside dan 

Outside 

Langkah untuk memberi efek Contour adalah 

 Buat satu obyek dasar  

 Aktifkan tool Contour pada toolbox sisi sebelah kiri 



46 
 

 Tandai obyek tesebut 

 Tekan dan tahan dengan menggerakan arah mouse ke luar atau ke dalam 

 Atau memilih property bar menu Contour yang tetera di atas dengan pilihan seperti : To Center, 

Inside dan Outside Contour 

 

4.4.3 EFEK DISTORT 

Efek Distort adalah efek yang dapat merubah bentuk objek aslinya menjadi abstrak dengan perintah 

yang anda inginkan dengan pilihan  

 Push and Pull,  

 Zipper dan  

 Twister. Bentuk yang dibuat berupa teks atau obyek dasar ( Shape ) 

 

 

4.4.4 EFEK DROP SHADOW 

Efek Drop Shadow adalah efek untuk memberi sebuah bayangan pada objek yang dapat anda atur 

arah datang cahayanya. 
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4.4.5 EFEK ENVELOPE 

efek yang digunakan untuk merubah bentuk shape maupun teks dalam bentuk elastik , melengkung , 

simetris dan asimetris. bentuk Envelope terbagi menjadi beberapa kategori, yaitu :  

 Straight Line,  

 Single arc ,  

 double arc dan  

 Unconstrained. 

 

4.4.6 EFEK EXTRUDE 

Efek Extrude adalah efek yang dapat membuat satu objek menjadi 3D dengan dimensi baik teks 

ataupun shape ( bentuk dasar ) 
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4.4.7 EFEK TRANSPARENCY 

Efek Transparency adalah efek yang merubah objek menjadi transparan. 

 

4.5 ALIGN AND DISTRIBUTE 

Untuk pengaturan dan letah dari beberapa obyek vector dapat diatur dengan menggunakan  Align 
dan Distribute dalam penataan atau posisi obyek yang berada pada obyek yang lain 

 

4.5.1 SHORTCUT ALIGN 

 B – Alignmen Bottom-Rata Bawah 

 T – Alignmen Top-Rata Atas 

 R – Alignmen Right-Rata Kanan 

 L – Alignmen Left-Rata Kiri 

 E – Center Horizontally-Terpusat Secara Horizontal 

 C – Center Vertically-Terpusat Secara Vertikal 

 C & E – Alignmen Center-Bertumpu ditengah setelah diratakan tengah Horizontal kemudian 

ditumpuk ditengah objek. 

 P – Center to page-Objek ke Tengah Halaman 
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4.5.2 SHORTCUT DISTRIBUTE 

 Shift+T – Distribute Top/Distribusikan ke Atas 

 Shift+B – Distribute Bottom/Distribusikan ke Bawah 

 Shift+L – Distribute Left/Distribusikan ke Kiri 

 Shift+R – Distribute Right/Distribusikan ke Kanan 

 Shift+E – Distribute Centers Horizontally/Distribusikan ke Tengah Secara Horizontal 

 Shift+C – Distribute Centers Vertically/Distribusikan ke Tengah Secara Vertikal 

 Shift+P – Distribute Spacing Horizontally/Distribusikan untuk Spasi objek secara Horizontal 

 Shift+A – Distribute Spacing Vertically/Distribusikan untuk Spasi objek secara Vertikal 

 Shift+E & E – Distribute Vertically and Align Horizontally/Distribusikan secara Vertikal kemudian 

diluruskan secara Horizontal 

 Shift+C & C – Distribute Horizontally and Align Vertically/Distribusikan secara Horizontal dan 

Sejajarkan Secara Vertikal. 

4.6 FUNGSI DAN JENIS ALIGN 

Align memiliki beberapa bagian seperti align top, align bottom, align left, align right, align centers 

vertically, align centers horizontally, dan Center to Page. 

4.6.1 FUNGSI ALIGN HPRIZONTAL 

4.6.2 ALIGN  TOP 

Align Top digunakan untuk membuat objek menjadi rata atas,   

 Siapkan dua kotak/rectangle dan satu text 

  buat ukuran berbeda ada yang besar dan ada yang kecil 

 kemudian text tersebut letakkan di dalam kotak kecil dan anda group object dengan shortcut 

Ctrl+G  

 

 

4.6.3 ALIGN BOTTON 

Digunakan untuk meratakan obyek pada obyek lain di posisi bawah 

 seleksi kedua obyek, dalam hal ini kotak dan bintang 

 aktifkan Align and Distribute, 

 pilih Align Botton 
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4.6.4 ALIGN CENTER HORIZONTAL 

 

4.6.5 ALIGN CENTER VERTICAL 

 

4.6.6 ALIGN LEFT 
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4.6.7 ALIGN RIGHT 

 

 

4.7 DISTRIBUTE (PENGATURAN JARAK OBJEK) 

digunakan untuk mengatur jarak obyek satu dengan obyek yang lain  

4.7.1 DISTRIBUTE EXTENT SELECTION 

Terbagi menjadi beberapa bagian pengaturan jarak atau spasi yang terseleksi dalam beberapa obyek 

ke dalam sebuah obuek 

4.7.2 DISTRIBUTE TOP 

 

4.7.3 DISTRIBUTE TOP LEFT 

 

4.7.4 DISTRIBUTE TOP RIGHT 
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SOAL  LATIHAN 

1 Sebutkan beberapa bentuk manipulasi obyek vector ! 

2 Jelaskan masing-masing bentuk manipulasi beserta gambar!  

3 Gambarkan bentuk manipulasi gambar dengan cara Intersection 

4 Buatlah dua buah obyek dengan menggunakan manipulasi obyek dengan menggunakan 

efek blen dan shadow 

5 Buatlah satu obyek dengan menggunakan efek extrude dalam bentuk teks dan obyek 
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BAB 5 
MENGGUNAKAN STYLE 

 
 

 Pada bab in membahas tentang cara  penggunaan style dan Style style pada teks dan obyek 

 Diharapkan mahasiswa mampu menerapkan dan memahami bagaimana cara penerapan style 

pada program CorelDaw 

 

Dalam desain grafis, konsistensi di seluruh elemen desain membantu seniman menciptakan simetri 

dan keseimbangan. Ini adalah atribut yang membuat desain visual menyenangkan secara 

estetika. Namun, seperti yang dapat Anda bayangkan, mendefinisikan ulang setiap atribut objek 

dapat dengan cepat menjadi membosankan saat desain Anda menggunakan puluhan garis, bentuk, 

dan huruf. 

Menggunakan Style dan pengaturan Style dalam proyek desain merampingkan proses desain, 

memungkinkan seniman untuk mencapai konsistensi visual tanpa beban pekerjaan berulang. Style 

dapat digunakan untuk menyimpan atribut objek, dan rangkaian Style dapat digunakan untuk 

menyimpan grup atribut.  

5.1 APA ITU STYLE DALAM DESAIN GRAFIS? 
Style adalah seperangkat atribut desain untuk suatu objek. Misalnya, saat bekerja dengan garis , 

Style mungkin mewakili bobot atau warna garis. Dan saat bekerja dengan font , Style mungkin 

mewakili ukuran atau warna teks. 

Contoh umum atribut Style meliputi: 

 Jenis huruf 

 Ukuran Poin Font 

 Warna 

 Transparansi 

 Garis besar 

 Berat Garis 

Anda mungkin menemukan Style jika Anda terbiasa dengan perangkat lunak pengolah kata seperti 

Google Docs atau Microsoft Word. Pengaturan teks Style tajuk yang telah diformat sebelumnya 

adalah salah satu contoh Style yang diterapkan pada font untuk memastikan pemformatan yang 

konsisten di seluruh dokumen. Style bekerja pada dasarnya sama di semua aset desain grafis. 

Mengedit Style yang ada atau membuat Style Anda sendiri dapat dilakukan untuk tampilan yang 

dapat disesuaikan. Di CorelDRAW terdapat beberapa Style atau style yang dapat di gunakan seperti 

 Style obyek 

 Style warna 

 Style teks 
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Gambar : 4. 1( syle Graphic dan Teks ) 

Pengolahan Style atau style tidak saja dilakukan di program pengolahan kata seperti Microsoft Word 

, tetapi di program Grafispun mampu untuk mengolah dan mengatur serta membuat Style 

Menggambar dan menulis seperti yang terdapat pada CorelDraw. 

5.2 MEMBUAT, MENERAPKAN DAN MENGEDIT STYLE 

Style adalah sekumpulan atribut pemformatan. Pada saat menerapkan Style ke objek, semua atribut 

Style diterapkan ke objek tersebut dalam satu langkah. Style dapat menghemat banyak waktu jika 

harus menerapkan pemformatan yang sama ke beberapa objek. 

Ada Style grafis dan Style teks. Style gambar terdiri dari pengaturan isian dan kerangka yang dapat 

Anda terapkan pada objek gambar seperti persegi panjang, elips, dan kurva. Misalnya, jika Anda 

memiliki sekelompok objek dalam gambar yang menggunakan satu Style grafis, Anda dapat 

mengubah isiannya secara bersamaan dengan mengedit Style grafis. Untuk informasi selengkapnya 

tentang menerapkan isian, lihat "Mengisi objek". Untuk informasi selengkapnya tentang mengubah 

tampilan kerangka, lihat "Memformat garis dan kerangka." 

Style teks adalah sekumpulan pengaturan teks seperti jenis dan ukuran font. Style teks juga dapat 

menyertakan atribut isian dan kerangka. Misalnya, Anda dapat membuat Style yang menerapkan 

font AvantGarde 72 titik dengan isian tekstur. Ada dua jenis Style teks: artistik dan paragraf. Anda 

juga dapat mengubah properti teks artistik dan paragraf default. Misalnya, Anda dapat mengubah 

properti teks artistik default, sehingga setiap objek teks artistik yang Anda buat memiliki 

pemformatan yang sama. Untuk informasi tentang teks default, lihat "Mengubah properti dasar 

teks". Untuk membuat gambar atau Style teks dari properti objek yang ada atau dari awal, saat Style 

disimpan. Penerapkan Style ke objek, program menimpa properti teks atau gambar yang ada dengan 

properti Style saat ini. Untuk menggunakan Style di gambar lain, dapat dilakukan dengan cara 

menyalin Style ke gambar baru atau menyimpan Style di template. Jika proses menyalin atau 

mengimpor Style dengan nama yang sama dengan Style yang sudah ada, program akan mengganti 

nama Style dengan menambahkan angka ke nama Style. Utuk dapat mengganti nama Style, kecuali 

itu adalah Style default, atau juga dapat mengubah properti objek kembali ke Style sebelumnya jika 

dalam membuat terjadi kesalahan atau memutuskan bahwa Style sebelumnya lebih cocok untuk 

objek tersebut. 

Setelah membuat Style, untuk dapat mengedit propertinya dan menemukan objek apa pun 

menggunakan Style tertentu. Misalnya, dapat menemukan semua objek yang menggunakan Style 
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grafis default. Menemukan objek dengan Style tertentu membuat pengeditan Style itu menjadi lebih 

efisien. 

5.3 UNTUK MEMBUAT GAMBAR ATAU GAYA TEKS DARI SUATU OBJEK 

 Klik kanan objek yang properti style. 

 Klik style Simpan properti styel tersebut. 

 Aktifkan satu atau beberapa kotak centang berikut: 

 Graphic style 

 Artistic text style 

 Paragraph text style 

 Pilih style dari daftar  

 Klik tombol Layout pilih Propoerties 

 Ubah property Text, fill atau Outline properties 

5.4 MEMULAI MEMBUAT STYLE OBYEK 

 Aktifkan konteks menu Style yang terdapat pada menu Tool, Graphic and Text Style 

 

Gambar : 4. 2 ( Graphic and Text Style ) 

 Gambar berikutnya aka tampil seperti gambar 4.3 dengan pilihan bentuk style yang akan 

digunakan, baik Graphic Style, Artistic Text Style dan Paragraph Text Style 
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Gambar : 4. 3 ( pilihan bentuk style ) 

 Misalnya anda pilih Graphic Style, berikan nama dari styel tersebut, misalnya style gambar 

 Berikutnya anda buat desain gambar shape yang diformat dengan memberikan warna arsiran, 

garis bentuk garis, warna garis dan seterusnya. 

 Jika format gambar sudah di buat dan dianggap selesai, maka klik drag gambar tersebut 

 Arahkan ke posisi nama dari styel Graphic tersebut seperti yang terlihat pada gambar 4.4 

 

Gambar : 4. 4 ( Memasukkan Style gambar ) 

5.5 MENERAPKAN STYLE OBYEK / GRAPHIC 

Untuk menerapkan Style atau style yang sudah anda buat seperti langkah tersebut diatas, maka 

selanjutnya 

 Buat gambar bebas pada area stage / halaman CorelDraw 

 Seleksi gambar tersebut, klik kanan pada gambar tersebut  

 Pilih style, Apply, pilih nama dari style yang sudah dibuat 
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Gambar : 4. 5 ( Penerapan Style ) 

 Maka akan dihasilkan seperti gambar berikut  

 

Gambar : 4. 6 (hasil penerapn Style obyek ) 

 

 Ulangi langkah seperti tersebut diatas unuk membuat style yang lain 

MENERAPKAN  STYLE PADA TEKS 

Untuk menerapakan style pada teks sama seperti pada penerapan style pada obyek 

 Buat teks pada dokumen 

 Format teks tersebut baik warna, jenis huruf ,bentuk Change case ) 

 Seleksi atau tandai teks tersebut yang sudah diberikan format warna atau jenis huruf 

 Klik dan geser ke arah Flyout atau konteks menu 
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  

Gambar : 4. 7( bentuk Text Style ) 

5.6 PENERAPAN STYLE TEKS 

Untuk menerapkan style teks pada teks yang lain secara teknis sama seperti pada penerapan style 

pada obyek 

 

Gambar : 4. 8 ( Penerapan Teks Style ) 

 

5.7 PAGARAPH STYLE 

Bentuk style yang ke tiga adalah paragrpah style, jika sebelumnya anda sudah belajar bagaimana 

membuat dan menerapkan bentuk style pada obyek dan dan teks. Style pada paragraph cara dan 

menerapannya sama seperti obyek dan teks style. 

 Aktifkan text tool pada toolbox 

 Tahan dan geser samapai terbentuk sebuah frame dengan garis yang putus-putus 

 Lepaskan jika area paragrpah sudah terbentuk 
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Gambar : 4. 9 ( Frame are untuk teks paragrpah ) 

 Ketikkan teks dalam bentuk pargraph atau teks yang panjang dalam bentuk kalimat bebas 

 Atur atau setting dengan format seperti pengaturan Alignment, jenis huruf, ukuran huruf, warna 

dan seterusnya 

 Klik dan geser ke arah Obyek style docker 

 

Gambar : 4. 10 ( Style paragraph ) 

5.8 PENERAPAN STYLE PARAGRAPH 

 Buat kelimat pada dokumen CorelDraw 

 Klik kanan kalimat tersebut 
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Gambar : 4. 11 ( Penerpan Paragraph Style ) 

 

 

Gambar : 4. 12 ( sebelum dan sesudah penerapan paragraph style ) 

SOAL LATIHAN 

1 Apa yang anda ketahui tentang style ? 

2 Penggunaan style sangat penting, Mengapa?Jelaskan alasannya! 

3 Sebutkan bentuk style yang terdapat dalam Coreldraw! 

4 Jelaskan secara singkat cara menerapan style pada obyek ! 

5 Jelaskan dan berikan contoh Peneran Style pada Paragrpah! 
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BAB 6 
TIPOGRAFI & FONT VEKTOR 

 

 Pengolahan bentuk vector tidak hanya pada shape atau bentuk obyek dasar saja,melainkan 

dapat ditepakn pada teks 

 Mahasiswa diharapkan dapat mengolah teks dan memanipulasinya seperti pada obyek di 

pembahasan bab sebelumnya 

Tipografi adalah sahabat desainer yang tidak dapat dipisahkan satu dengan yang lainnya, saling 

berkaitan satu sama yang lainnya. Mengubah kata-kata biasa menjadi karya seni yang kreatif. Tetapi 

keterampilan tipografi mencakup lebih dari sekadar huruf artistik, itu adalah bagian penting untuk 

memastikan teks dapat dibaca. Tipografi memberikan hierarki visual yang menarik perhatian ke 

detail yang tepat saat informasi diberikan. Menemukan keseimbangan yang tepat untuk elemen 

tipografi dapat memengaruhi aksesibilitas desain sebanyak nilai artistiknya. 

Banyak elemen tipografi adalah vektor. Font vektor umum dalam desain grafis karena menawarkan 

skalabilitas mudah yang sama seperti gambar vektor. Mereka membuat pilihan yang mudah untuk 

elemen teks yang harus tetap terbaca dan sesuai dengan ruang visual yang telah ditentukan. 

6.1 MENGAPA TIPOGRAFI PENTING BAGI DESAINER VEKTOR? 

Tipografi adalah seni huruf, khususnya yang melibatkan tipografi, ukuran titik, dan jarak garis untuk 

membuat pengaturan visual yang menarik dari huruf artistik dan dapat dibaca. Mirip dengan jenis 

seni digital lainnya, font dikategorikan sebagai file raster atau file vektor . 

Font yang disimpan sebagai gambar bitmap atau raster berisi kumpulan piksel yang terdistorsi saat 

mengubah ukuran font. Saat bekerja dengan file-file ini, desainer perlu membuat aset terpisah untuk 

setiap aplikasi guna mengakomodasi pengubahan ukuran. Di sisi lain, font vektor menawarkan 

skalabilitas penuh menggunakan file teks yang berisi serangkaian titik dan garis di samping 

persamaan matematika yang memungkinkan penskalaan proporsional. 

Gambar raster dapat dianggap hanya melihat lapisan atas desain, mirip dengan kanvas yang dicat 

dengan hati-hati di mana warna latar belakang dipilih dengan hati-hati untuk menghasilkan 

mahakarya akhir yang diinginkan. Tidak ada jalan kembali dan mengedit lapisan di bawah bagian 

dalam file raster. Jenis file ini menyimpan data gambar sebagai piksel, membuatnya sangat sulit 

untuk memanipulasi objek individu setelah digabungkan. 

6.2 DASAR-DASAR TIPOGRAFI 

Tipografi adalah seni memadukan kata-kata tertulis dengan desain kreatif untuk merancang elemen 

visual yang menarik dan mudah dibaca. Tipografi menambahkan sedikit pizazz pada kata-kata 

tertulis. Sebagai seorang desainer, Anda akan mendalami estetika penggunaan tipografi dalam aset 

kreatif Anda. Berikut adalah beberapa elemen dasar yang perlu Anda ketahui untuk bekerja dengan 

tipografi. 

6.2.1 JENIS HURUF 

Jenis huruf adalah kumpulan karakter, atau mesin terbang, yang dibuat dalam estetika desain 

tertentu. Di dalam setiap jenis huruf, karakter akan menampilkan fitur visual yang serupa dan ukuran 

yang proporsional sehingga seluruh koleksi menampilkan tampilan yang kohesif. Secara fungsional, 
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tipografi dikategorikan sebagai font serif atau sans serif. Perbedaannya sederhana. Font serif 

mengandung garis dekoratif atau lancip yang disebut serif, sedangkan font sans serif tidak 

mengandung elemen tersebut. 

6.2.2 JARAK 

Di samping bentuk dan proporsi huruf, spasi huruf adalah kunci untuk membuat font yang dapat 

dibaca. Saat spasi huruf tidak teratur, otak harus bekerja lebih keras untuk membaca teks karena 

kepadatan visual. Jarak huruf yang terlalu dekat atau terlalu jauh sulit dibaca, mengurangi daya tarik 

desain secara keseluruhan. 

6.2.3 KERNING 

Kerning huruf adalah ruang visual antara huruf dalam font. Sementara desainer tipografi akan 

mengatur spasi huruf, ada kalanya seorang desainer ingin menyesuaikan spasi menggunakan kerning 

manual untuk mengakomodasi aplikasi desain tertentu. Spasi dan, lebih khusus lagi, kebutuhan 

untuk menyesuaikan spasi saat mendesain adalah sesuatu yang tidak dipertimbangkan oleh orang 

awam. Namun, sebagai seorang desainer, kerning dan spasi huruf akan menjadi variabel konstan 

dalam karya desain Anda. 

Dalam aplikasi kreatif, kerning manual dapat digunakan untuk mengatur huruf dengan proporsi 

berbeda menggunakan penempatan dan tumpang tindih untuk menciptakan daya tarik visual. 

6.3 KONTRAS 

Seperti semua elemen visual dalam desain, kontras font penting dalam menciptakan visibilitas yang 

membuat desain Anda terbaca. Kontras adalah keseimbangan visual antara elemen tipografi di latar 

depan desain dengan warna di latar belakang. Dalam hal menciptakan desain yang bagus untuk dunia 

digital modern, kontras yang tepat merupakan elemen desain penting untuk estetika dan 

aksesibilitas. 

6.4 HYPHENATING TEXT 

Merupakan anda hubung dapat digunakan untuk memecah kata jika seluruh kata tidak pas di akhir 

baris. Anda dapat menggunakan tanda hubung secara otomatis dengan menggunakan definisi 

pemenggalan prasetel yang dikombinasikan dengan pengaturan pemenggalan Anda sendiri. Anda 

dapat mengatur jumlah minimum karakter sebelum dan sesudah tanda hubung 

Anda dapat menyisipkan tanda hubung opsional dalam sebuah kata untuk menghasilkan jeda kata 

tertentu di akhir baris. Anda juga dapat membuat definisi kustom yang menentukan lokasi tanda 

hubung opsional dalam kata tertentu setiap kali Anda mengetik, menempel, atau mengimpor kata 

dalam aplikasi. 

6.5 MENSETING PEMENGGALAN TEKS 

 Masukkan atau kerikkan teks dalam bentuk paragrpah dalam text frame yang telah dibuat 

sebelumnya 

 Klik menu Text, pilih Hyphenation Setting 

Aktifkan atau contreng pilihan Auto Automatically hyphenate paragraph text pada check box. 

 Klik ok 

6.6 TEKS DI CORELDRAW 
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Bahasa adalah bagian besar dari cara anda berkomunikasi, dan desainer grafis sering kali ditugaskan 

untuk menemukan cara visual yang kreatif untuk mengkomunikasikan informasi. Desain ini sering 

berpusat pada aset artistik tetapi menyertakan elemen bahasa mulai dari huruf individual atau kata 

tunggal hingga potongan salinan pendek dan blok teks yang lebih panjang. 

Sebagai seorang desainer, memasukkan bahasa ke dalam karya Anda membutuhkan penguasaan 

elemen tipografi. Memahami cara kerja font vektor dan elemen desain apa yang membuat font lebih 

atau kurang dapat dibaca, bersama dengan bagaimana dan kapan memanipulasi elemen ini, akan 

membantu Anda membuat desain yang terampil. 

6.7 BENTUK TEKS DI COREL DRAW 

Penulisan teks di Coreldraw memiliki tiga bentuk teknik penulisan, yaitu 

 Artistic teks 

 Paragraph teks dan 

 Symbol 

6.7.1 ARTISTIC TEXT 

Bentuk artistik digunakan untuk menuliskan teka atau kalimat pendek atau yang tidak membutuhkan 

alenia atau pargraph yang panjang. Untuk menuliskan teks dalam bentuk artistik langkahnya 

 Aktifkantool Text tool  

 Klik pada area kerja atau stage yang kosong  

 Tentukan posisi kursor, selanjutnya ketiikan kalimat atau kata 

 

Gambar :6. 1 (Artistic Text ) 

6.7.2 PARAGRAPH TEXT 

Bentuk teks yang kedua adalah bentuk paragrpah, artinya penulisan teks yang membutuhkan alenia 

atau pargaraph dengan kalimat yang panjang, seperti pengetikan pada aplikasi MsWord atau 

Indesign. Penulisan teks dalam bentuk paragrpah ini dengan cara 

 Klik tools Text  

 Klik dan tahan sampai membentuk sebuah Boundariy atau Frame pada area kerja 

 Klik dan tuliskan kalimat pada area kerja atau stage di Coreldraw 
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Gambar :6. 2 ( Pargraph Text ) 

 

Gambar :6. 3 ( Bentuk Paragrpah Teks ) 

6.8 PENGATURAN PARAGRAPH 

Untuk mengatur format teks atau alenia / pargraph dapat dilakukan dengan mengaktifkan  menu 

Text dan pilih beberapa pilihan format teks sesuai dengan kebutuhan 
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Gambar :6. 4 ( Pengaturan Teks dan Paragraph ) 

6.9 SYMBOL 

Bentuk teks yang ke tiga adalah berbentuk Symbol. Artinya teks dapat beruba menjadi symbol 

dengan cara dikonversi. Teks yang sudah berubah menjadi symbol tidak dapat di ubag bentuk dan 

jenis serta type teksnya, atau tidak bisa diubah atau diedit baik jenis font atau stylenya. 

 

Gambar :6. 5 ( Bentuk teks sebelum diubah menjadi symbol ) 

Pada gambar tersebut diatas, merupakan bentuk teks yang sebelum diubah atau dikonversi dalam 

bentuk symbol, dapat diubah jenis Font atau style nya 
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Gambar :6. 6 (Bentuk Text yang sudah dikonversi menjadi symbol ) 

Teks atau kalimat yang sudah dikonversi dalam bentuk symbol tidak dapat lagi di ubah baik jenis font 

mapun style fontnya, seperti yang terlihat pada gambar 6.6. 

Teks vector dalam bentuk symbol dapat di fariasi dengan menggunakan Shape Tools untuk 

pengaturannya. Berikut hasil fariasi teks dalam bentuk vector symbol 

 Buat teks bebas pada ara kerja CorelDraw 

 Aktifkan menu  

 

Gambar:6. 7 ( konversi text vector dalam bentuk symbol ) 

 Klik shape Too  

 Seleksi titik ( node ) pada teks sesuai dengan keinginan 
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Gambar:6. 8 ( Hasil Fariasi Vector Text Symbol ) 

Jika ditaberikan tabahan efek artistix media maka akan berubah tampilanya seperti pada gambar 

berikut ini: 

 

Gambar:6. 9 ( Pemebrian efek aristic media ) 

6.10 PENGATURAN VECTOR TEXT DENGAN PATH 

Teks dalam bentu artistik maupun pargraph dapat di fariasi dengan menggunakan Efek Fit Text to 

Path yang berada di menu Text. 

Untuk membuat fariasi dalam bentuk Fit Text To Path dengan mengikuti langkah sebagai berikut ini : 

 Buat jalur atau path dengan menggunakan Tool Pen tool, Bezier Tool, Polilyne Tool 

 

Gambar:7. 1 ( Tool untuk membuat Path ) 

 Atau cukup dengan menngambar dengan bentuk dasar seperti Ellipse ( lingkaran ) 

 

Gambar:7. 2 ( Path dalam bentuk lingkaran ) 

 Pilih tool  Text , klik pada garis path 
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Gambar:7. 3 ( memposisikan tool text pada path ) 

 Ketikan kalimat /  tek pada path tersebut 

 

Gambar:7. 4 ( Teks yang sudah menempel pada path ) 

 Atur posisi teks dengan tanda yang terblok ( highlight)  kuning pada gambar 7.4 

 

Gambar:7. 5( hasil proses fit text to path ) 
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6.11 BENTUK PARAGRAPH PATH 

Selain bentuk artistik teks yang dapat dibentuk dengan path, bentuk pargraphpun dapat pula di 

berikan path dengan target didalam path, bukan diluar path seperti pada artistic text. Untuk 

membuat pargraph path , berikut langkah pembuatannya: 

 Buat path dalam bentuk lingkaran atau bentuk konversi dari obyek dasar 

 

Gambar:7. 6( Bentuk paragraph Path ) 

 Ketikan teks dalam bentuk alenia beberapa baris kalimat 

 

Gambar:7. 7 ( penerapan pargraph path ) 

6.12 PARAGRAPH PATH DALAM BENTUK KOLOM 

Paragraph yang sudah terbentuk dan masuk kedalam sebuah obyek lingkaran, dapat di ubah menjadi 

naskah berkolom. 

 Tandai atau seleksi teks yang sudah terbentuk paragrpah path 

 Aktifkan menu text, pilih Coloumn 
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Gambar:7. 8 ( Bentuk kolom pada paragraph path ) 
 

 

SOAL LATIHAN 

1. Sebutkan 3 bentuk vector yang berbentuk text 

2. Jelaskan secara singkat ke tiga bentuk text vector 

3. Gambarkan 3 bentuk varisai teks dalam bentuk vector symbol 

4. Gabungkan antara vector text artistic dengan pargraph dengan kalimat bebas ! 

5. berikan contoh text dalam bentuk symbol dengan memebrikan efek artistic media ! 
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BAB 7 
BEKERJA DENGAN LAPISAN( LAYER ) DI CORELDRAW 

 

  Desain vektor sangat ideal untuk semua jenis seni digital, dari karya abstrak sederhana 

hingga gambar dan lukisan vektor yang kompleks . dalam  mengerjakan bagian yang lebih 

rumit dan mendetail, layer adalah Tool desain grafis yang bagus untuk membantu mengatur, 

mengelompokkan, dan menerapkan pengeditan dan efek. 

 Mahasiswa diharapkan dapat memahami, mengerti dan dapat menerapkan fungsi layer di 

coreldraw 

7.1 LAPISAN ATAU LAYER DALAM DESAIN GRAFIS 

Dalam perangkat lunak desain grafis, lapisan adalah level berbeda tempat Anda dapat menempatkan 

objek seperti garis vektor , bentuk, dan elemen lainnya.  Layer digunakan untuk memisahkan bagian 

dari suatu gambar atau gambar, memungkinkan Anda untuk mengedit dan memanipulasi elemen 

individu dari karya seni Anda secara terpisah. 

Lapisan juga dapat membantu menggabungkan dua gambar atau lebih sekaligus menjaga agar 

komponen dan elemen sebenarnya dari gambar tersebut tetap terpisah. Karena desain vektor 

berbasis objek—setiap garis, bentuk, atau elemen lain dalam gambar vektor adalah elemen 

tersendiri dan tidak perlu menggunakan lapisan untuk memisahkan atau menggabungkan 

elemen. Namun, beberapa manfaat utama dan fitur lapisan membuatnya layak digunakan 

dalam proses desain vektor Anda . 

Lapisan dapat ditumpuk, digabungkan, disembunyikan, dikunci, disamarkan, dan diatur ulang. Dalam 

beberapa format, layer disebut dengan nama lain. Misalnya, dalam SVG, lapisan disebut "grup". Anda 

juga dapat melihat lapisan yang disebut lapisan bentuk. 

 

Gambar:7. 1 ( menu Docker Layer ) 

7.2 DOCKER OBJECT MANAGER 

Semua gambar CorelDRAW terdiri dari objek yang ditumpuk. Urutan vertikal objek-objek ini  urutan 

susun berkontribusi pada tampilan gambar. Cara efektif untuk mengatur objek-objek ini adalah 

dengan menggunakan bidang tak terlihat yang disebut layer. 
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Setiap membuka halaman baru pada halaman master akan dijadikan sebagai nilai awal ( default). 

Halaman awal yang dijadikan sebagai nilai awal atau default berisi Guide Layer dan Layer 1. Guide 

Layer menyimpan  panduan yang terdapat pada layer 1 sebagai layer 1 atau lapisan awal. Untuk 

mengambar obyek di halaman pertama maka akan di tambahkan layer 1, kecuali jika menghendaki 

layer yang berbeda. 

Di halaman master  sebagai halaman virtual  berisi tentang semua layer yang terpasang pada Docker 

obyek Manager. Halaman master dapat ditambahkan atau dikurangi jumlah layer yang tercantum 

atau tersimpan, seperti : Header, Footer, atau background statis, secara Default  hamalam master 

berisi lapisan : 

 Guides : berisi panduan yang digunakan untuk semua halaman dokumen 

 Dekstop : berisi objek yang berada di luar batas halaman gambar. Lapisan ini memungkinkan 

Anda menyimpan objek yang mungkin ingin Anda sertakan dalam gambar di lain waktu 

 Grid : berisi garis bantu yang digunakan untuk semua  hamalan dokumen dan merupakan lapisan 

yang berada pada lapisan paling bawah. 

Lapisan yang dijadikan Default pada halaman master tidak dapat dihapus atau disalin (dikopi). 

Lapisan yang ditambahkan ke dalam halama master muncul atau tampil dibagian sisi atas , keculai 

jika urutannya diubah secara manual dengan menyesuaikan nama dari layer. 

Untuk menambahkan konten baik berupa teks, obyek atau paragraph, terlebih dahulau harus 

memilih layer yang dikehendaki supaua layer tersebut aktif. Untuk melihat lapisan layer pada menu 

Docker Manager, dapat dilakukan dengan memilih  dari berbagai tampilan yang memungkinkan 

menampilkan halaman, layer atau semua obyek yang tertera pada obyek manajer. Tampilan yang 

ingin dipilih tergantung pada kerumitan dan project yang dibuat.Misalnya dokumen multi halaman 

sehingga Anda dapat menavigasi dengan lebih mudah dan hanya melihat satu halaman dalam satu 

waktu. Tampilan Manajer lapisan memungkinkan Anda melihat dan menyusun ulang semua lapisan 

yang memengaruhi halaman saat ini, termasuk lapisan master. 

 

Gambar: 7. 2 (Gambar dapat disusun dengan menempatkan objek pada berbagai layer) 

7.3 CARA KERJA LAYER  VECTOR 

Pada prinsipnya cara kerja layer di corel dengan di Photoshop sama, meskipun pada kenyataanya 

layer di corel draw jarang digunakan, karena secara otomatis setiap obyejk yang dibuat di area kerja 

akan membentuk layer sendiri., untuk menampilkan docker layer di corel caranya 

 Aktifkan menu tool 

 Pilih Object Data manager 
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Gambar:7. 3( Pengaturan Layer ) 

 

7.4 LAYER MASK 

Lapisan memungkinkan Anda untuk menjaga elemen individu agak terpisah dalam file gambar 

tertentu. Layer masking akan memungkinkan Anda untuk memblokir bagian tertentu dari gambar 

Anda tanpa menghapus atau menghapusnya. Ini adalah cara yang mudah dan tidak merusak untuk 

menyembunyikan sebagian gambar tanpa menghapusnya secara permanen. 

Layer mask sangat bagus saat Anda membuat gambar komposit dan kolase. Mereka juga ideal untuk 

menghapus atau menyembunyikan objek dan memfokuskan hasil edit Anda hanya pada area 

tertentu daripada seluruh lapisan. 

7.4.1 BENTUK LAYER MASK 

Layer mask digunakan untuk memnipulasi tampilan obyek dalam layer dengan cara menampilkan 

atau menyembunyikan semua atau sebagian obyek. Bentuk layer mask dapat dilakukan dengan cara 

 Menentukan  obyek (shape ) atau teks sebagai  target  

 Menentukan gambar atau image satu atau beberapa gambar  

 Seleksi gambar tersebut 

 Aktifkan menu  
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Gambar:7. 4 ( Layer Masking ) 

 

Gambar:7. 5 ( Hasil Proses Layer Mask ) 

 

Gambar:7. 6 ( Ilustrasi Posisi Layer ) 
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7.4.2 ALASAN PENGUNAAN LAYER 

Menambahkan kompleksitas visual ke gambar 

Lapisan memungkinkan Anda untuk menggabungkan beberapa elemen dari gambar sumber yang 

berbeda, menambah kerumitan visual pada karya seni Anda. Anda dapat menerapkan filter dan 

efek—seperti bayangan jatuh atau efek warp—ke satu atau lebih lapisan, menambahkan lebih 

banyak tekstur dan minat. Tanpa menggunakan lapisan, menciptakan kedalaman dan melacak semua 

tingkat elemen dalam desain Anda bisa jadi menantang. 

7.4.3 MEMBUAT HIERARKI VISUAL 

Anda dapat lebih mudah membuat kedalaman dan hierarki visual dalam desain Anda dengan 

lapisan. Saat Anda memisahkan elemen ke dalam lapisan yang berbeda, Anda dapat dengan mudah 

mengatur ulang lapisan tersebut untuk mengubah elemen mana yang muncul di latar depan gambar 

Anda dan mana yang menjadi bagian dari latar belakang. Ambil selangkah lebih maju, dan tambahkan 

efek seperti drop shadow untuk memberi gambar Anda lebih kontras dan mendalam. 

7.4.4 MEMODIFIKASI ELEMEN SECARA TERPISAH 

Dengan lapisan, Anda dapat memodifikasi elemen gambar secara terpisah. Meskipun ini merupakan 

manfaat yang melekat dari format gambar vektor berbasis objek, menggunakan lapisan memberikan 

tingkat tambahan untuk organisasi dan kontrol. Saat Anda memiliki grup elemen yang berbeda pada 

lapisan terpisah, mudah untuk mengunci atau menyembunyikan lapisan untuk mengisolasi aspek 

tertentu dari gambar Anda. 

7.4.5 MENGEDIT ELEMEN LATAR BELAKANG 

Saat mengerjakan desain vektor kompleks yang terbuat dari banyak objek vektor berbeda, sulit untuk 

mengerjakan objek latar belakang jika terkubur di bawah elemen lain. Dengan lapisan, Anda dapat 

menyembunyikan lapisan latar depan dan mengerjakan objek latar belakang tanpa menyeretnya ke 

bagian atas gambar Anda. 

7.4.6 MENERAPKAN EFEK NONDESTRUKTIF 

Saat Anda menerapkan efek ke gambar, Anda dapat melakukannya secara langsung atau dengan 

lapisan terpisah. Menerapkan efek ke lapisan terpisah dapat membalikkan perubahan kapan 

saja. Demikian pula, Anda dapat menerapkan layer mask, yang dapat Anda sempurnakan atau hapus 

nanti. Tanpa layer dan layer mask, Anda akan langsung mengedit dan menghapus objek dan 

potongan gambar Anda, membuatnya lebih sulit untuk diperbaiki nanti. 

7.4.7 MENERAPKAN EFEK DI SELURUH HALAMAN 

Menggunakan lapisan master memungkinkan Anda menerapkan elemen, mengedit, atau efek di 

beberapa halaman dokumen. Ini menghemat waktu yang mungkin diperlukan untuk menggandakan 

sesuatu secara manual, seperti header atau footer, ke beberapa halaman. 

7.4.8 MENGUBAH PROPERTI LAYER 

Untuk setiap membuat lapisan yang baru terdapat pengaturan properti tampilan, pengeditan dan 

cara mencetak serta mengekspor yang diaktifkan secara default. Anda dapat mengubah nilai 

tersebut baik mengaktifkan dan menonaktifkan pengaturan layer sebagai master layer. 
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Gambar: 7. 7 ( properti mengubah Layer ) 

7.5 MENAMPILKAN DAN MENYEMBUNYIKAN LAYER 

Anda dapat menampilkan dan menyembunyikan layer dalam gambar. Mneyembunyikan layer 

memungkinkan anda mengidentifikasikan dan mengedit  obyek di layer lain secara cepat. 

7.6 MENCETAK DAN MENGEKSPOR LAYER 

 Pengaturan properti mencetak  dan mengekspor  untuk sebuah layer atau lapisan untuk 

mengkontrol apakah sebuah layer  dapat ditampilkan  dalam gambar  yang akan dicetak atau yang 

akan di ekspor. 

7.7 MENGATUR PENGEDITAN LAYER 

Selain pemgaturan tersebut diatas, anda dapat mengatur layer dengan cara mengedit layer yang aktif 

serta dapat pula mengunci layer tersebut untuk menjaga supaya layer tidak berubah, maka dengan 

demikian layer tidak dapat di edit. 

7.8 MENGGANTI NAMA LAYER  

Dalam mengedit layer mengganti nama dapat dilakukan dengan dengan mudah dalam docker layer 

denga tujuan mengurutan nama layer sebelum atau sesudahnya yang saling berkaitan satu dengan 

yang lain. 

7.9 MEMINDAH DAN MENGKOPI LAYER DAN OBYEK 

Anda dapat memindan dan juga menduplikasi layer dan obyek dalam satu halaman atau antar 

halaman. Atau dapat juga anda memindah dan menyalin  obyek yang terpilih ke layer yang baru 

termasuk layer master. 

Memindah atau menyalin layer akan mempengaruhi urutan-urutan layer yang sudah tersusun dalam 

Docker menu dengan menyesuaikan urutan abjad dari nama layer tersebut. Tidak hanya menyalin 

layer, memindahkan layer juga akan mempengaruhi posisi atau tempat dimana layer atau obyek 

tersebut aktif atau berada. 
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LATIHAN SOAL 

1. Sebutkan dan jelaskan layer dan fungsinya ! 

2. Berikan contoh penggunaan layer  pada obyek 

3. Bagaimana cara memodifikasi layer yang sudah pernah dibuat? 

4. Bagaiman cara mengaktifkan layer ? 

5. Bagaimana cara menjadi layer menjadi default ? 
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BAB 8 
BEKERJA DENGAN SIMBOL 

 

 Aplikasi CorelDRAW memungkinkan Anda membuat objek dan menyimpannya sebagai simbol. 

Simbol didefinisikan sekali dan dapat direferensikan berkali-kali dalam sebuah gambar. Setiap 

kali Anda menyisipkan simbol ke dalam gambar, Anda membuat turunan dari simbol tersebut.  

 Definisi simbol, serta informasi tentang instance, disimpan dalam pengelola simbol, yang 

merupakan bagian dari file CorelDRAW (CDR).  

 Menggunakan simbol untuk objek yang muncul berkali-kali dalam gambar membantu 

mengurangi ukuran file. 

 

Ketika anda berbicara tentang simbol, itu bisa berarti satu dari dua hal. Terkadang simbol mengacu 

pada mesin terbang atau karakter khusus yang Anda gunakan di samping teks, misalnya tanda pound 

atau simbol mata uang. Namun, dalam tutorial ini, anda mengacu pada simbol sebagai objek atau 

kumpulan objek yang dibuat oleh Tool di CorelDRAW. 

Menggunakan simbol dan membuat pustaka simbol adalah cara yang bagus untuk menghemat 

banyak waktu dalam proses desain dan mengurangi ukuran file, terutama jika Anda telah berulang 

kali menggunakan simbol yang sama dalam file desain Anda. 

Jika Anda mengedit simbol dalam file CorelDRAW, itu akan secara otomatis memperbarui semua 

contoh lain dari simbol itu di seluruh dokumen, sehingga Anda tidak perlu memperbarui setiap objek 

satu per satu. Anda mungkin menggunakan simbol saat mengulang logo, saat menggunakan elemen 

desain arsitektur atau mode, kartografi, dan lainnya. 

8.1 MEMBUAT,MENGEDIT DAN MENGHAPUS SIMBOL 

Simbol adalah objek yang didefinisikan sekali dan dapat direferensikan berkali-kali dalam sebuah 

gambar. Anda dapat memiliki banyak contoh simbol dalam gambar dengan sedikit dampak pada 

ukuran file. Simbol membuat pengeditan gambar menjadi lebih cepat dan mudah, karena perubahan 

yang dilakukan pada simbol secara otomatis diwarisi oleh semua instance. 

Simbol dibuat dari objek. Saat Anda mengonversi objek menjadi simbol, simbol baru ditambahkan ke 

pengelola Simbol, dan objek yang dipilih menjadi sebuah instance. Anda juga dapat membuat simbol 

dari beberapa objek. Anda dapat mengedit simbol; setiap perubahan yang Anda buat memengaruhi 

semua instance dalam gambar. Tuas pemilihan untuk simbol berbeda dari pegangan untuk objek. 

Tuas pemilihan untuk simbol berwarna biru; gagang pemilihan untuk objek berwarna hitam. Anda 

juga dapat menghapus instance simbol dan membersihkan definisi simbol yang tidak terpakai. 

Purging menghapus semua definisi simbol yang tidak disertakan dalam gambar 

Untuk membuat symbol baru, langkahnya sebagi berikut: 

 Buat sebuah gambar atau shape di  area kerja 

 Seleksi gambar tersebut 

 Aktifkanmenu ,Edit pilih Symbol, New Symbol 
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Gambar : 8. 1 ( membuat simbol baru ) 

 

Gambar : 8. 2 ( pemberian nama simbol baru ) 

8.2 CARA MEMBUAT SIMBOL 

Dalam contoh ini, saya ingin membuat peta gambar untuk sebuah kota bernama Green Valley dan 

membuat beberapa simbol berbeda yang saya rencanakan untuk digunakan dalam peta ini. 

 Buat objek (atau sekumpulan objek) dengan menggunakan Tool di CorelDRAW seperti biasa. 

 Pilih objek atau sekumpulan objek, klik kanan dan pilih  Simbol > Buat Simbol Baru. 

 Beri nama simbol di  kotak dialog Buat Simbol Baru  dan klik  OK . 

 

Gambar : 8. 3 ( langkah membuat symbol baru ) 
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 Buka  Window > Dockers > Symbols  untuk membuka  Symbols  docker (atau 

tekan  Ctrl  +  F3 ). 

 Untuk menempatkan simbol di dokumen Anda, cukup seret dari   docker Symbols . 

 

Gambar : 8. 4 ( menempatkan symbol pada dokumen ) 

8.3 CARA MENGEDIT SIMBOL 

 Klik simbol apa pun, lalu pilih  Edit  dari bilah Tool peka konteks yang akan muncul. 

 

Gambar : 8. 5 ( mengedt symbol ) 

 Lakukan pengeditan yang Anda inginkan pada simbol ini (tambahkan bentuk atau elemen 

desain untuk menyertai gambar ini, ubah warna atau posisi objek, dan seterusnya). 

 Setelah selesai mengedit simbol, klik  Selesai . 
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Gambar : 8. 6 ( hasl pengeditan symbol ) 

8.4 CARA MEMBANGUN PERPUSTAKAAN SIMBOL 

 Buka dokumen kosong dan salin dan tempel simbol yang baru saja Anda buat ke dalam 

dokumen baru ini. 

 Tempel atau buat simbol lain yang Anda inginkan menjadi bagian dari perpustakaan ini dan 

simpan masing-masing sebagai simbol individual seperti yang anda lakukan sebelumnya. 

 Buka  File > Save as  lalu pilih drive dan folder tempat Anda ingin menyimpan perpustakaan. 

 Kemudian beri nama Perpustakaan Simbol Anda. 

 Pilih  CSL – Corel Symbol Library  dari  kotak daftar Save as type  . 

 Lalu klik  Simpan . Sekarang, semua simbol dan contoh simbol disimpan dalam dokumen ini. 

 

Gambar : 8. 7 ( menambahkan symbol di librar)y  

8.5 CARA MENGIMPOR /BERBAGI PERPUSTAKAAN SIMBOL 

Setelah membuat pustaka simbol anda dapat mengimpornya kembali ke CorelDraw sehingga dapat 

mengaksesnya dengan mudah untuk proyek berulang. 

 Di  folder  docker  Simbol , klik Simbol Lokal  atau  Simbol Jaringan . 

 Klik  ikon Opsi  dan klik  Impor LIbrary 
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.  

Gambar : 8. 8 ( mengeksport symbol ) 

 Temukan dan pilih koleksi atau perpustakaan. 

 Jika Anda ingin menyalin pustaka ke folder Simbol, aktifkan   kotak centang Salin pustaka 

secara lokal . Ini akan memungkinkan anda untuk membagikan perpustakaan ini sehingga 

anda dapat menggunakannya untuk banyak proyek. 

 Lalu klik  Oke . 

Untuk mengakses perpustakaan baru dari proyek apa pun: 

 Buka   folder  Simbol Lokal dari docker Simbol  . 

 Pilih  folder Simbol  , lalu pilih perpustakaan yang baru Anda buat. 

 

Gambar : 8. 9 ( cara mengakses symbol baru ) 

Sekarang Anda akan memiliki akses ke semua simbol yang baru saja di buat dan cukup melakukan 

drag dan drop ke dokumen sesuai kebutuhan. 

Dan begitu saja, anda telah membuat perpustakaan simbol yang dapat anda gunakan berulang kali 

dengan banyak proyek yang menghemat banyak waktu dalam prosesnya! 
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Gambar : 8. 10 ( hasil penerapan symbol pada sebuah gambar peta ) 

LATIHAN SOAL 

1. Fungsi symbol dalam penerapan di desain grafis adalah ! 

2. Bagaimana cara memerbaiki nama symbol yang sudah tersimpan dalam docker menu  

3. Bagaimana cara menyisipkan symbol dalam sebuah dokumen di coreldraw ? 

4. Bentuk warna sebuah obyek yang dijadikan sebagai symbol , tetap atau berubah! 

5. Apa fungsi dan manfaat dalam membuat symbol dalam desain grafis ? 
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 BAB 9 
PRINT OUT OBYEK VECTOR 

 
 

 Menggunakan CorelDRAW, Anda dapat mencetak satu atau lebih salinan dari gambar yang 

sama. dan dapat menentukan jenis halaman dan rentang halaman yang ingin Anda cetak. 

 mahasiswa diharapkan mengerti dan memahami bagaimna teknik mencerak bentuk vector 

dalam coreldraw 

Dalam teknik mencetak dokumen terutama bentuk vector yang dibuat menggunakan aplikasi 

Coreldraw terdapat beberapa teknik dalam menghasilkan cetakan yang sesuai dengan keinginan 

anda.perlu diketahui dalam mencetak di aplikasi coeldraw terdapat satu kelemahan dalam hasil 

cetakannya, yaitu warna yang dihasilkan tidak 100 persen sama dengan obyek yang anda buat dalam 

dokumen coreldraw. 

9.1 MENYIAPKAN DOKUMEN UNTUK PREPRESS DAN PRINT 

Tutorial tertulis ini memberikan instruksi yang jelas untuk menyiapkan dokumen CorelDRAW Anda 

untuk dikirim ke printer untuk berbagai macam pekerjaan yang berbeda. 

Dengan CorelDRAW anda dapat membuat file untuk berbagai macam aplikasi: cetak, web, signage, 

fashion, ilustrasi, dll. Masing-masing membutuhkan konfigurasi yang berbeda. Sekarang mari anda 

bicara tentang bagaimana mempersiapkan pekerjaan anda untuk pre-press dan printing. 

Tentu saja, ada beberapa jenis pekerjaan: majalah, kartu nama, brosur, dll. Hampir tidak mungkin 

membicarakan semuanya, tetapi sebagian besar pengaturannya umum untuk semua pekerjaan. Tapi 

ingat: sangat penting untuk berbicara dengan perusahaan percetakan sebelum memulai, karena 

setiap perusahaan memiliki aturan dan persyaratannya sendiri. Biaya merupakan faktor penting 

dalam pekerjaan apa pun, dan perubahan apa pun (seperti perubahan ukuran atau warna yang 

digunakan), meskipun minimal, dapat mengakibatkan perubahan pada harga akhir pekerjaan. 

Aturan pra-cetak dan pencetakan berikut berlaku umum untuk hampir semua pekerjaan dan bisnis. 

Anda akan berbicara secara umum dan kemudian anda akan melakukan dua pekerjaan sebagai 

contoh (kartu nama dan majalah). 

9.2 MENGATUR DOKUMEN 

Mari anda mulai dari awal. Buka CorelDRAW, dan buka File > New (Ctrl+N). 
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Gambar : 9. 1 ( pengaturan dan pemilihan dokumen ) 

Sekarang, anda harus memilih ukuran final pekerjaan anda yang sebenarnya. Artinya, jika ukuran 

kartu nama harus 90×50 mm (atau 3,5×2 inci), ini harus menjadi ukuran dokumen. Harap jangan 

menempatkan banyak kartu pada halaman A4, karena ini tidak hanya berarti pekerjaan dan waktu 

ekstra, tetapi juga dapat menyebabkan kesalahan. 

Di kotak dialog "Buat Dokumen Baru", Anda akan menemukan beberapa item berguna, seperti nama 

pekerjaan, jumlah halaman, mode warna, pengaturan warna, dll. tetapi anda akan membahas lebih 

detail tentang masing-masing item tersebut. item nanti. 

Jika Anda sudah memiliki dokumen A4 baru, jangan khawatir, Anda dapat mengubah ukuran halaman 

di Property Bar. 

 

Gambar : 9. 2 ( pembuatan dokumen baru ) 

Ada beberapa preset di daftar drop-down Page Size di sebelah kiri Property Bar. Anda dapat 

menambahkan milik Anda sendiri jika ingin mengakhiri daftar dengan mengeklik tombol "Edit daftar 

ini..." di bagian bawah tarik-turun. Catatan: Anda dapat mengakses menu yang sama lebih cepat 

dengan mengklik dua kali batas halaman. 

9.3 MENDEFINISIKAN MARGIN 
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Ini adalah bagian dari Penyiapan Halaman, tetapi ini merupakan langkah penting. Setelah 

menentukan ukuran halaman, Anda harus memilih margin halaman dalam dan luar. Di dalam margin, 

karena tidak baik menempatkan teks atau objek di dekat tepi halaman  ̶ ini bukan hanya tentang 

estetika atau visual desain  ̶meskipun ada sedikit perbedaan saat memotong dan tidak terlihat ada 

margin di seandar bagian dalam. 

Untuk menambahkan margin dalam, klik dua kali pada batas halaman dan arahkan ke Dokumen > 

Panduan > Preset, pilih lebar margin yang diinginkan (tergantung pekerjaan), lalu klik tombol 

"Terapkan Preset". 

 

Gambar : 9. 3 ( pengaturan margin dokumen ) 

Jika Anda menggunakan latar belakang, atau jika ada gambar di dekat tepi halaman, Anda harus 

menambahkan ruang ekstra di bagian luar. Margin luar ini disebut “bleeding” dan sangat penting 

karena pemotongan tidak selalu seakurat yang diharapkan. Margin tambahan ini sangat membantu 

proses pasca cetak. Anda dapat menentukan ukuran Bleed saat Anda memilih ukuran halaman. Klik 

dua kali di tepi halaman, atau buka Tool > Opsi > Dokumen > Ukuran Halaman. Pada bagian “Bleed” 

Anda dapat mengatur jarak yang diinginkan (biasanya 3mm atau 0.125″). Selain itu, Anda dapat 

membuat area ini terlihat dengan memilih “Show bleed area“. 
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Gambar : 9. 4 ( pengaturan dokumen setup ) 

Tapi itu tidak cukup untuk mengatur jarak berdarah, itu juga perlu memperluas objek (latar belakang, 

misalnya), untuk melampaui batas halaman. Jangan khawatir jika gambar lebih besar dari area bleed, 

gambar akan terpotong secara otomatis saat membuat file PDF atau mencetak. 

9.4 KUALITAS GAMBAR 

Salah satu masalah paling umum terkait dengan kualitas gambar. Misalnya, jika Anda mengunduh 

gambar dari internet, seperti wallpaper, itu akan bagus untuk dilihat di layar Anda tetapi tidak untuk 

dicetak. Sebagian besar gambar di internet berkualitas rendah (misalnya 72 dpi atau 96 dpi), karena 

mempercepat pengunggahan gambar ke web. Namun resolusi ini kurang bagus untuk dicetak, karena 

gambar akan “pixelated” dengan tepi bergerigi dan hasil cetakannya jelek. 

Untuk mencetak foto berwarna sebaiknya menggunakan gambar dengan resolusi seandar 300 dpi 

dan menggunakan mode warna CMYK. "300 dpi" adalah nilai standar, karena pembuat gambar dan 

CTP (komputer-ke-pelat) menggunakan LPI (garis per inci) sebagai satuan ukuran. 

 Jika file menghasilkan 150 baris per inci, resolusi maksimal yang tersedia adalah 150×2 = 300 dpi. 

 Jika outputnya 175 lpi, resolusi maksimum yang tersedia adalah 350 dpi. 

 Jika output file pada 200 lpi, resolusi maksimalnya adalah 400 dpi, memang 300 dpi sudah cukup 

baik. 

Sejauh ini, tidak ada perangkat pencetakan di pasaran dengan lebih dari 200 lpi, jadi kualitas terbaik 

adalah antara 300 dan 400 dpi. 

Oleh karena itu, jika Anda mengirim gambar dengan resolusi 600 dpi atau lebih tinggi, ini hanya akan 

menghasilkan file yang lebih lambat dan lebih besar tetapi tidak akan meningkatkan resolusinya. 

Beberapa orang mengirim gambar dengan 1800 dpi, 2400 dpi dan lebih banyak dan ini hanya 

menghasilkan file yang jauh lebih besar, tetapi tidak meningkatkan kualitas keluaran. Anda akan 
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melihatnya lebih baik di layar jika memperbesar gambar, tetapi hasil cetakannya adalah 300/400 dpi. 

Beberapa orang bertanya tentang printer inkjet yang mengklaim dapat mencetak pada 2400 dpi atau 

lebih. Ada banyak kebingungan mengenai hal ini, karena mereka menggunakan "dpi" (berbicara 

tentang titik cetak per inci), yang merupakan kualitas cetak, bukan resolusi gambar. Dan, untuk 

printer format besar (plotter), tidak perlu menggunakan bitmap resolusi tinggi  ̶ sebaliknya, semakin 

besar ukurannya semakin rendah resolusi yang dibutuhkan. Tetapi, 

Kesalahan umum lainnya: hati-hati saat memperbesar atau memperkecil ukuran gambar. Jika Anda 

mengimpor gambar, misalnya 15×10 cm pada 300 dpi, tetapi ingin memperbesarnya menjadi 45×30 

cm, resolusinya menurun secara proporsional (dalam contoh ini akan menjadi 100 dpi), sehingga 

kualitasnya akan terpengaruh. Sebaliknya, jika Anda memperkecil gambar menjadi 3×2 cm, 

resolusinya akan meningkat secara proporsional (dalam contoh ini, 1500 dpi). Keduanya buruk, jadi 

Anda harus berhati-hati dengan resolusinya. Ingat, 300 dpi harus menjadi resolusi pada ukuran 

sebenarnya, bukan sebelum memperbesar atau memperkecil. 

9.5 MENDEFINISIKAN WARNA 

Langkah selanjutnya adalah menentukan Color Mode dan Color Profile. Di bawah Tool> Manajemen 

Warna Anda akan melihat dua opsi dialog; satu untuk pengaturan umum (Pengaturan Default), dan 

lainnya relatif hanya untuk dokumen saat ini (Pengaturan Dokumen). Keduanya sangat penting. 

"Mode Warna" mengacu pada cara anda menggunakan file, dalam hal ini, untuk pencetakan 

berkualitas tinggi. Pilihan pertama adalah antara mode warna RGB atau CMYK. RGB memiliki corak 

yang lebih cerah tetapi hanya bagus untuk printer web dan desktop (misalnya printer inkjet) dan 

plotter, tetapi tidak untuk pencetakan komersial. RGB memiliki 16,8 juta warna dan CMYK hanya 

64.000 tetapi semua printer komersial menggunakan CMYK. Jika Anda menggunakan profil warna 

RGB, mode warna akan berubah saat file dikirim untuk dicetak, dan mungkin hasilnya buruk atau 

tidak akurat. Kemudian, Anda harus memilih CMYK sebagai "mode warna primer" di kedua dialog 

Tool > Manajemen Warna. 

 

Gambar : 9. 5 ( Manajemen warna ) 
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Memilih profil warna CMYK tidak berarti semua objek akan menjadi CMYK secara otomatis. Saat 

Anda mengimpor gambar, atau menyalin/menempelkan teks, jika gambar tersebut adalah RGB maka 

akan disimpan sebagai RGB hingga Anda mengubah mode warna. Cara terbaik adalah menggunakan 

perangkat lunak pengedit gambar (seperti Corel PHOTO-PAINT, disertakan dengan CorelDRAW 

Graphics Suite, atau Corel PaintShop Pro), untuk mengoreksi gambar sebelum mengimpornya ke 

CorelDRAW. Tetapi jika Anda memasukkan gambar RGB, Anda selalu dapat mengubah mode warna 

nanti. (CATATAN: Anda dapat membuka File > Document Properties... untuk memastikan bahwa 

semua objek berada dalam mode CMYK) Untuk alasan ini, sangat penting untuk memiliki manajemen 

warna yang baik. 

Untuk menyesuaikan profil warna buka Tool > Manajemen Warna dan sesuaikan pengaturan warna 

untuk dokumen saat ini dan pengaturan keseluruhan (Pengaturan Default dan Pengaturan 

Dokumen). Tidaklah cukup untuk mengatur pengaturan default, karena setiap dokumen dapat 

memiliki profil warnanya sendiri. 

Manajemen Warna memerlukan penjelasan yang sangat luas karena tidak ada "profil warna 

universal" untuk semua dokumen. Jadi, Anda harus menyesuaikan pengaturan untuk setiap jenis 

pekerjaan. Misalnya, Anda harus mengubah profil warna Anda sesuai dengan kertas dokumen yang 

digunakan. 

Namun tidak semua dokumen bisa menggunakan mode warna CMYK, karena membutuhkan 4 tinta. 

Jika Anda membuat file dengan hanya dua atau tiga warna (misalnya biru dan kuning) mungkin yang 

terbaik adalah menggunakan hanya dua atau tiga warna (Warna Spot), seperti warna Pantone. Selain 

itu, tidak semua warna dapat dicetak menggunakan CMYK, misalnya “Emas”, “Perak”, dll. Beberapa 

warna cerah hanya dapat diperoleh dengan menggunakan tinta khusus, dan ini tidak dapat dicapai 

dengan CMYK. Warna spot juga penting untuk "objek non-cetak" (misalnya, garis besar untuk die cut) 

atau "objek yang dicetak berlebih" (seperti pernis UV). Bukan hanya vektor yang dapat menggunakan 

warna titik, bitmap juga dapat menggunakan Warna Titik. Pada Menu Bitmap, buka Mode > Duotone 

dan ubah bitmap menjadi satu (“monoton”), atau lebih banyak warna titik. 

9.6 MENGIRIM FILE & PUBLISHING KE PDF 

Jika Anda mengirim yang asli berkas .CDR, Anda harus memberikan semua informasi yang diperlukan. 

Cara terbaik untuk melakukannya adalah dengan membuka File >Collect for Output…, yang membuat 

folder baru dengan salinan file .CDR, font yang digunakan, dan profil warna. Jika Anda menggunakan 

gambar yang ditautkan secara eksternal, file ini juga akan disertakan. Secara opsional, Anda juga 

dapat membuat PDF. 

Tidak baik jika file dibuka di versi program yang berbeda karena beberapa hal dapat berubah. 

Misalnya, isian CorelDRAW X7 sangat berbeda dengan versi sebelumnya dan juga memungkinkan 

transparansi selektif. Untuk alasan ini, jika Anda menyimpan kembali file tersebut sebagai versi 

sebelumnya, program akan menanyakan apakah Anda ingin mengonversi teks menjadi kurva dan 

isian menjadi bitmap. 

Pokoknya, ada alternatif yang bagus: buat PDF. Untuk melakukan ini, Anda dapat membuka File > 

Publikasikan ke PDF (atau buka File > Ekspor (CTRL+I), dan pilih PDF). Namun tidak cukup hanya 

dengan membuat PDF, karena tidak semua PDF memiliki konfigurasi yang sama. Misalnya, PDF untuk 

web akan menghasilkan PDF dengan kualitas rendah tetapi akan menjadi file kecil, cocok untuk 

dilampirkan ke email atau digunakan di halaman web. Tetapi untuk pencetakan, anda membutuhkan 
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yang sebaliknya: gambar dengan kualitas dan resolusi tinggi. Pengaturan PDF juga merupakan topik 

yang memerlukan penjelasan panjang, tetapi ini melebihi ruang lingkup tutorial saat ini. Ada banyak 

konfigurasi yang berbeda, sesuai alur kerja masing-masing perusahaan. Tapi anda mengusulkan 

format sederhana yang seharusnya bekerja dengan sebagian besar keluaran pekerjaan: pilih PDF X-3 

di daftar drop-down PDF Preset, lalu buka "Pengaturan" dan ubah "Kompatibilitas" ke Acrobat 8.0 

atau lebih tinggi. Mengapa? Karena PDF X-3 adalah standar yang baik tetapi memiliki kompatibilitas 

default dengan Acrobat 4.0, yang tidak mendukung transparansi dan lensa. Masalah ini diselesaikan 

dengan mengubah kompatibilitas. 

Pada tab "Warna" pada Pengaturan PDF, secara default semua warna akan ditampilkan sebagai 

CMYK, tetapi Anda dapat mengubahnya menjadi "Native" terutama jika Anda menggunakan warna 

Spot. Selalu aktifkan opsi untuk menyematkan Profil Warna. Jika Anda menggunakan cetak berlebih 

khusus pada dokumen Anda, jangan lupa untuk membiarkan opsi ini aktif (diaktifkan secara default). 

Pada tab "Objek" Anda memiliki beberapa opsi penting. PDF X-3 standar, jadi Anda tidak perlu 

mengubah apa pun. Secara khusus, tidak perlu mengonversi teks menjadi kurva, karena PDF akan 

menyematkan semua font. Gunakan opsi ini hanya jika Anda menggunakan font dengan batasan 

untuk mencetak, tetapi hanya beberapa font yang mengalami masalah ini. Opsi 'Ubah ke kurva' akan 

membuat file yang lebih besar dan kompleks, dan beberapa RIP akan mengalami masalah saat 

memprosesnya. Karena font akan disematkan, tidak perlu mengubah teks menjadi kurva. 

Pada tab "Prepress" Anda memiliki opsi untuk mengaktifkan "Bleed Limit". Bahkan jika dokumen saat 

ini tidak memiliki bleed aktif, Anda dapat mengaktifkannya saat membuat PDF. Tapi ingat bahwa 

objek harus keluar dari batas halaman. Mengaktifkan “Bleed Limit” tidak secara otomatis menambah 

ukuran objek yang digunakan untuk membuat desain. Opsi lain yang seringkali berguna adalah 

mengaktifkan "Tanda Pangkas" untuk menunjukkan batas desain anda. Untuk alasan ini penting 

bahwa ukuran halaman adalah ukuran sebenarnya. 

9.7 MEMBUAT KARTU 

Pertimbangkan beberapa contoh praktis. Pertama, anda akan membuat beberapa kartu nama. 

Seperti yang anda lihat di awal, anda menentukan ukuran halaman menjadi 90×50 mm (atau 3,5×2 

inci). Ingat ini hanya contoh, ukurannya bisa berbeda dari model ke model. 

Kemudian anda klik dua kali pada tepi lembar untuk menentukan margin dan menambahkan Bleed 

3mm. 

Kemudian, masih di panel Opsi, anda akan pergi ke Dokumen > Panduan > Preset > dan pilih 

"Ditentukan Pengguna" untuk membuat margin dalam 5mm. Jangan lupa untuk mengklik tombol 

"Terapkan Preset". Anda mengklik OK, dan anda memiliki halaman yang siap untuk mulai bekerja. 
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Gambar : 9. 6 ( layout membuat kartu ) 

 

Langkah berikutnya: 

 Simpan hasil perubahan label dengan nama yang sudah disiapkan, dengan tujuan apabila anda 

ingin membuat kartu nama berijutnya tidak perlu mengatur lagi, karena penyimpanan layout 

tersebut bisa dipakai seterusnya 

 

Gambar : 9. 7 ( Menyimpan hasil layout kartu nama ) 

 

 Menesain kartu nama 
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Gambar : 9. 8 ( desain kartu nama ) 

 Melihat hasil akhir kartu nama sebelum proses mencetak 

 

Gambar : 9. 9 ( print preview ) 

Apa yang terjadi jika anda memerlukan beberapa nama berbeda di kartu nama anda? Jika hanya dua, 

anda bisa menduplikat isi halaman (Layout > Duplicate page), tapi jika anda ingin membuat beberapa 

halaman, cara terbaik adalah dengan membuat Master Layer. Untuk melakukannya, pilih logo dan 

latar belakang, dan pilih Edit > Potong (atau CTRL + X). Lalu, buka docker Object Manager (Window > 

Dockers > Object Manager), dan pilih dari menu docker “New Master Layer – All pages“. Atau anda 

dapat mengklik ikon New Master Layer (semua halaman) di bagian bawah docker Object Manager. 
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Gambar : 9. 10 ( pembuatan style ) 

Jika mau, Anda dapat mengganti nama layer ini. Kemudian cukup “tempel” (Edit > Tempel atau 

CTRL+V), untuk menempatkan logo dan latar belakang pada layer baru. Anda dapat membuat 

halaman sebanyak yang anda butuhkan, dan semua akan memiliki logo dan latar belakang yang 

sama. Tetapi keuntungannya adalah, itu hanya akan ada sekali di file: dan jika Anda memodifikasi 

satu elemen, itu akan diubah di semua halaman. Untuk menghindari perubahan secara tidak sengaja, 

anda dapat "mengunci" layer tersebut dengan mengklik ikon gembok di Object Manager. Kemudian, 

anda hanya perlu memilih halaman dan layer (biasanya, Layer 1), dan memasukkan teks yang sesuai 

(Nama, Telepon, dll) 

Jika anda mengirim file ke Print (File > Print atau CTRL+P), perhatikan bahwa satu kartu per lembar 

muncul. Tapi jika anda mengaktifkan menu ke File > Print Preview, anda bisa melakukan Imposition 

(Tool kedua di sebelah kiri), serta mengatur jarak antar kartu. Replay bisa identik atau berbeda, 

mengapa anda memilihnya sebagai nomor halaman. Anda juga dapat menambahkan Tanda Pangkas 

(Tool ketiga), dan banyak opsi lainnya. 

 

Gambar : 9. 11 ( pengaturan margin cetak dokumen ) 

Tapi anda hanya perlu membuat file PDF, pratinjau cetak tidak diperlukan. Cukup ikuti langkah-
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langkah di atas dan buat PDF dengan beberapa halaman individual, masing-masing dengan tanda 

potong dan hapus. Pengenaan akan dilakukan secara otomatis menggunakan program alur kerja 

berbasis PDF (seperti Heidelberg Kodak Preps atau MetaDimensions). 

9.8 MERANCANG MAJALAH 

Sebagai desain majalah, prosesnya serupa tetapi dengan sedikit perbedaan. Langkah pertama, 

seperti biasa, adalah menentukan format majalah. Misalkan majalah yang telah selesai berukuran 

19×27 cm lalu klik dua kali pada batas halaman (ini membawa anda ke: Tools > Options > Workspace 

> Document > Page Size), dan pilih ukuran dari dua halaman secara bersamaan: 38×27 cm ( berdarah 

seperti biasa, harus 3mm tetapi bisa lebih jika diinginkan). 

Pada pilihan menavigasi ke "Layout" dan memilih "Booklet" dari daftar drop-down Layout. Penting 

untuk memverifikasi bahwa opsi "Halaman muka" aktif untuk melihat majalah saat dibaca: halaman 

pertama dan terakhir sebagai halaman individual (seolah-olah majalah ditutup), lalu halaman 2-3, 4 -

5, dll. Namun, saat membuat PDF, setiap halaman akan menjadi satu per satu, sebagaimana 

mestinya, sehingga Anda dapat menggunakan perangkat lunak pemaksaan apa pun. Jika objek atau 

gambar menempati dua halaman, maka akan dipotong secara otomatis. 

 

Gambar : 9. 12 ( print layout pembuatan majalah ) 

Seperti pada kartu nama, buka "Tools > Opsi > Ruang Kerja > Dokumen > Panduan > Preset > 

Ditentukan Pengguna" dan pilih margin bagian dalam jika diinginkan. Jika diinginkan, anda dapat 

mengatur margin yang berbeda, misalnya anda dapat menyisakan 1,5 cm di bagian atas dan 1 cm di 

bagian bawah. Untuk ini, anda menonaktifkan opsi "Margin cermin". 

Jika anda ingin bekerja dengan kolom, anda juga dapat menentukan jumlah kolom dan jarak antar 

kolom di “Tools >Options > Workspace > Document > Guides > Preset > User Defined > Columns“. 

Detail penting adalah, jangan bingung dengan kolom Teks Paragraf yang melibatkan pemisahan blok 

teks menjadi dua atau lebih kolom (menu Teks >Kolom…). Membagi halaman menjadi kolom tidak 

secara otomatis memisahkan teks atau konten ̶ itu hanya referensi visual. 
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Kemudian, setelah mengklik Terapkan Preset, anda dapat menambahkan jumlah halaman yang 

diinginkan (Tata Letak > Sisipkan halaman), atau tekan tombol Turun Halaman). Anda sekarang siap 

untuk mulai bekerja. 

Untuk alasan ruang dan tidak menyimpang dari tema utama, maka pembahasan hanya pada  detail 

tentang cara mendesain majalah karena mungkin ada banyak pilihan desain. Ingatlah beberapa poin 

penting untuk dipertimbangkan: 

 Anda dapat menomori halaman secara otomatis (Tata Letak > Sisipkan Nomor Halaman > Di 

Semua Halaman) 

 Saat mengirim untuk dicetak (laser atau inkjet), secara default halaman terakhir dan pertama 

akan muncul bersamaan, seperti yang akan anda cetak. 

 Saat Anda membuat PDF (File > Publikasikan ke PDF atau File > Ekspor > PDF), anda akan 

memiliki halaman individual yang diperlukan untuk program pemaksaan. 

 Ingat, seperti yang sudah anda katakan, jangan lupa untuk menambahkan Bleed dan Crop 

Marks. 

 

LATIHAN SOAL 

1. Berikan langkah dalam melakukan percetak dokumen ! 

2. Berikan tiga bentuk hasil cetak dokumen ! 

3. Berikan langkah pembuatan label dan kartu nama 

4. Berikan contoh pembuatn majalah 

5. Berikan contoh poster dan cara pengaturannya 
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BAB 10 
MEMBUAT DATA MERGE 

 

Data merge digunakan untuk membuat penggabungan antara layout yang dibuat pada aplikasi 

Coreldraw dengan file data yang dibuat dengan mengunakan aplikasi Notepad atau langsung dari 

coreldraw itu sendiri 

Data merge digunakan untuk memudahkan dalam mencetak beberapa bentuk seperti piagam atau 

certifikat penghargaan serta dapat digunakan untuk mencetak surat undangan 

10.1 BERIKUT LANGKAH PEMBUATAN DATA MERGE 

 Buat desain sertifikat atau piagam 

 

Gambar: 10. 1 ( desain sertifikat ) 

 Buat data atau anggota, aktifkan menu File, Print Merge 

 Pilih Create / Load Merge Field 
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Gambar: 10. 2 ( menu Data Merge ) 

 Pilih Create new Text, klik next 

 

Gambar: 10. 3 ( langlah awal pembuatan data merge ) 

 Masukan Field ( judul Kolom )sesuai dengan jumlah kolom yang di inginkan 
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Gambar: 10. 4 ( memasukkan field / judul kolom ) 

 Masukkan data yang diakan diinputkan, tekan next 

 

Gambar: 10. 5 ( Input jumlah data yang diinginkan ) 

 Simpan data yang telah di inputkan dalam format (txt) 
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Gambar: 10. 6 ( Penyimpanan Data ) 

 Pilih Menu Insert Field pada toolbar Merge Data 

 

Gambar: 10. 7 ( Insert Data ke bagian desain sertifikat ) 
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Gambar: 10. 8 ( Penempatan Field ) 

 Untuk melihat hasilnya dari pengabungan data dan desain sertifikat,  aktifkan menu File , Data 

Mege, Pilih : Perfome Merge 

 

Gambar: 10. 9 ( melihat hasil sertifikat ) 
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Gambar: 10. 10 ( Hasil Preview, sebelum dicetak ) 

 Hasil dari sertifikat akan dicetak per halaman,jadi jika jumlah data yang diinputkan ada 5 record 

makan akan dicetak sebanyak 5  

 

Gambar: 10. 11( Hasil Akhir proses pembuatan sertifikat ) 

10.2 MENGEDIT DATA 

Untuk menambah data yang diundang atau mengedit data, berikut langkahnya: 

 Aktifkanmenu File, Print Merge, pilih Edit Merge Field 
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Gambar: 10. 12 ( Edit Data Merge ) 

 

Gambar: 10. 13 ( Tampilan Edit Data ) 

 Untuk edit data langlahya sama seperti pada saat membuat data baru 

 Selanjutknya simpan seperti pada penjelasan sebelumnya 

 Kemudian Gabungkan kembali antara data dan desain sertifikatnya. 
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